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Šta je novo u Microsoft Wordu 2007 u odnosu na Microsoft Word 2003 

Tri dijela trake 

Traka ima tri osnovne komponente. Dobro je znati kako se svaka od njih zove da bi razumjeli kako se 
koriste. 

  Kartice. Ima ih šest i nalaze se na vrhu. Svaka predstavlja oblast aktivnosti. 

  Grupe. Svaka kartica ima nekoliko grupa koje zajedno prikazuju srodne stavke. 

  Komande. Komanda može da bude bilo šta, dugme, padajuća lista ili polje za unos informacija. 

Traka sa alatkama za brzi pristup 

Traka sa alatkama za brzi pristup je mala oblast u gornjem lijevom uglu trake. Ona sadrži neke komande 
koje svakodnevno koristite: Sačuvaj, Opozovi radnju i Ponovi. Možete na nju da dodate svoje omiljene 
komande tako da vam budu dostupne bez obzira na to na kojoj se kartici nalazite. 

Da biste dodali komande na traku sa alatkama za brzi pristup, kliknite desnim tasterom miša na komandu 
koju želite da dodate, a zatim izaberite stavku Dodaj na traku sa alatkama za brzi pristup.  

Više komandi u dijalozima 

Kada u donjem desnom uglu grupe vidite strelicu  (nazvanu Pokretanje dijaloga), to znači da su za 
komande u grupi dostupne detaljne ili napredne opcije. Kliknite na strelicu da biste otvorili dijalog ili 
prozor zadatka u kojem možete da radite sa dostupnim opcijama. 

Šta se dogodilo sa menijem „Datoteka“? 

U programu Microsoft® Office Word 2007 meni Datoteka zamijenjen je dugmetom „Microsoft Office“ 

. Kliknite na ovo dugme u gornjem lijevom uglu prozora programa da bi dobili neke od osnovnih 
komandi koje ste ranije koristili za otvaranje, čuvanje i štampanje dokumenata. 

Na dnu menija izaberite komandu Opcije programa Word i pronaći ćete postavke programa koje 
kontrolišu stvari kao što su željene postavke pravopisa koji su se ranije nalazili u meniju Alatke pod 
stavkom Opcije. 

Korišćenje tastature  

Prečice koje počinju tasterom CTRL (na primer, CTRL+C za kopiranje ili CTRL+ALT+1 za Naslov 1) 
ostaju iste kao i u prethodnim verzijama programa Word. Međutim, promijenjene su tasterske prečice 
koje počinju tasterom ALT. 



Microsoft word 2007 

 

Fakultet za informacione tehnologije ‐ Univerzitet Mediteran |  8 

 

1. Pritisnite taster ALT.  

Pojaviće se oznake koje prikazuju slovne prečice.  

2. Pritisnite taster za karticu ili komandu trake sa alatkama za brzi pristup koju želite.  

o Ako pritisnete komandu trake sa alatkama za brzi pristup, komanda će se izvršiti.  

o Ako pritisnete slovnu prečicu kartice, videćete slovne prečice za sve komande na toj 
kartici. Pritisnite taster (ili tastere) za komandu koju želite. U zavisnosti od toga koju 
komandu odaberete, može biti izvršena radnja ili se može otvoriti galerija ili meni. U 
drugom slučaju možete da odaberete drugu slovnu prečicu.  

Napomena:  Većina pristupnih tastera Office 2003 menija (onih koji počinju tasterom ALT) i dalje radi. 
Međutim, potrebno je da znate kompletnu prečicu. Ne postoje podsjetnici na ekranu za tastere koje treba 
da pritisnete. 

Novi format datoteke 

Novi Word format datoteke dokumenta zasnovan je na novim Office Open XML formatima (XML je 
skraćenica za pojam Extensible Markup Language). Ne morate da razumijete XML. Samo imajte na umu 
da novi format zasnovan na XML formatu:  

 Pomaže da vaši dokumenti budu bezbjedniji tako što odvaja datoteke koje sadrže skripte ili 
makroe, olakšavajući identifikovanje i blokiranje neželjenog koda ili makroa.  

 Pomaže da veličine datoteka vaših dokumenata budu manje.  

 Pomaže da vaši dokumenti budu manje podložni oštećenjima.  

Oznaka tipa datoteke  Čemu služi  

.docx Standardni Word dokument bez makroa ili koda 

.dotx Word predložak bez makroa ili koda 

.docm Word dokument koji bi mogao da sadrži makroe ili 
kôd 

.dotm Word predložak koji bi mogao da sadrži makroe ili 
kôd 
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Rad sa ljudima koji nemaju Word 2007 

U programu Word 2007 možete da otvarate datoteke kreirane u prethodnim verzijama programa Word, od 
programa Word 95 do programa Word 2007. 

 Kada sačuvate datoteku koja je originalno kreirana u prethodnoj verziji programa, automatska 
opcija dijaloga Sačuvaj kao jeste da je sačuva u formatu prethodne verzije (.doc).  

 Kada sačuvate datoteku kao prethodnu verziju, ako neka od funkcija verzije 2007 nije 
kompatibilna sa prethodnom verzijom, alatka za proveru kompatibilnosti će vas obavijestiti o 
tome, a nove funkcije neće raditi.  

Obratite pažnju na to da se režim kompatibilnosti automatski uključuje kada otvorite Word 
datoteku koja je kreirana u prethodnoj verziji programa ili kada sačuvate datoteku kreiranu u 
verziji 2007 kao u prethodnoj verziji. 

Funkcija „Kontrolor kompatibilnosti“ automatski se pokreće. Možete da je pokrenete i ručno ako 
mislite da će neke funkcije u dokumentu biti nekompatibilne sa ranijim verzijama. Kliknite na 

dugme „Microsoft Office“ , postavite pokazivač na stavku Završi, a zatim izaberite stavku 
Kontrolor kompatibilnosti. 
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POKRETANJE MS WORDA 

 
1. preko dugmeta  START u donjem lijevom uglu ekrana (kliknemo na => Start, => Microsoft Word a 
u koliko se na brzom meniju ne nalazi ikona worda s nazivom onda slijedimo Start => All Programs => 
Microsoft Office => Microsoft Word 2007 

 

2. ili dvostrukim klikom na ikonu Microsoft Word-a koja se može nalaziti na radnoj površini. 
 

 

3. Treći način je START => RUN => upišemo u dijalog polje riječ WINWORD 

Zadatak 1      
(PRIPREMNI TEST ZA 
POLAGANJE MODULA)
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Program Microsoft Word 2007 učita se u memoriju sistema i automatski otvori novi dokument 
koji ima izgled praznog lista papira. 

Prilikom učitavanja programa pojavi nam se ovakav dijalog prozor 

 

Iz Microsoft Word-a 2007 izlazimo na tri načina: 

1. Kliknemo na ikonu Office Button-a  u gornjem lijevom uglu ekrana, čime se otvori meni 
u kojem odaberemo naredbu =>Close, ( isto se postiže kombinacijom tipki Alt+F4 ). 

2. Kliknemo na dugme => Zatvori na naslovnoj traci u gornjem desnom uglu. 

3. Kliknemo na dugme => Office Button , a zatim na naredbu => Exit Word koja se nalazi 
na dnu menija.  
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IZGLED PROZORA MICROSOFT WORD-a 2007 

 
Nakon aktiviranja ( pokretanja ) Microsoft Worda, pojavi se prozor Microsoft Word-a 2007 koji 
se sastoji od sljedećih elemenata:  

Naslovna traka – nalazi se na vrhu prozora i plave je boje. Na njoj piše ime trenutno aktivnog 
dokumenta i ime programa – Document1 - Microsoft Word. U desnom uglu naslovne trake 
nalaze se dugmad za minimiziranje prozora programa, smanjenje / maksimiziranje prozora 
programa i zatvaranje programa Word. 
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U gornjem lijevom uglu prozora za Word 2007 je Microsoft Office dugme . Kada kliknete 
dugme, pojavljuje se meni. Možete koristite meni za stvaranje nove datoteke, otvoriti postojeću 
datoteku, sačuvati datoteku, obavljati i mnoge druge zadatke.  

MS Word 2007  donosi svu funkcionalnost softvera koristeći se karticama prije nego padajućim 
menijima. 

Quick Access Toolbar 

 

Do Microsoft Office dugmeta je Quick Access toolbar. Quick Access toolbar vam pruža pristup 
naredbama koju često koristite. Po zadanom Save, Undo i Redo pojaviti na Quick Access 
toolbar. Možete koristiti Save da biste sačuvali datoteku,Undo za Rollback radnju koju ste uradili 
i Redo da ponovi akciju na kojoj ste uradili Rollback.  
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Naslovna traka - Title Bar 

 
 

Do Quick Access Toolbar je naslovna traka ili Title Bar. Naslovna traka prikazuje naslov 
dokumenta na kojem se trenutno radi. Word 2007 sam imenuje prvi otvoreni document u 
Document1 i svaki sledeći će biti Document 2, Document 3 sve dok korisnik sam ne da ime 
dokumentu. 

The Ribbon - Trake 

 
 

Koristimo naredbe da bi  nesto uradili u Microsoft Word-u. U programu Microsoft Word 2007, 
koriste se  trake za izdavanje naredbi. Trake se nalaze pri vrhu ekrana, ispod Quick Access 
toolbar  - a. 

U gornjem dijelu trake nalazi se nekoliko tabova: Klikanjem kartica prikazuje se  nekoliko 
srodnih grupa naredbi. Unutar svake grupe su povezana dugmad. Samim klikanjem na dugme 
izdaje se određena naredba. Takođe se može kliknuti i na dijalog boks koji se nalazi u desnom 
donjem uglu koji će dati neke dodatne naredbe. 

The Ruler  - Lenjir 

 

Lenjir se nalazi ispod trake. 

Možete koristiti lenjir za brzu promjenu formata vašeg dokumenta. Ako Vaš lenjir nije vidljiv, 
slijedite korake navedene ovdje: 
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1. Kliknite karticu View.  

2. Kliknite na potvrdni okvir pored Ruler ček boksa u Prikaži / Sakrij grupi (Show/Hide). I lenjir 
će se pojaviti ispod trake. 

 

ZNAČENJE VAŽNIJIH NAREDBI U OFFICE BUTTON MENIJU 

Naredbe u OFFICE BUTTON meniju imaju svoja značenja. Prilikom instalacije MS Office-a 
trake imaju standardne naredbe, dodatne naredbe mogu se instalirati zasebno. U niže prikazanim 
slikama uočit ćete razliku (jer su neke naredbe do-instalirane) za određene potrebe rada u Wordu. 

• Značenje naredbe Nova ( New ) kreiranje novog praznog dokumenta.  
• Otvori ( Open ) otvaranje postojećeg dokumenta ( datoteke ) sa određene lokacije ( 

CTRL+O ) . 
• Zatvori ( Close ) zatvaranje dokumenta.  
• Sačuvaj ( Save ) čuvanje ( snimanje, memoriranje ) dokumenta u datoteku na određenoj 

lokaciji  ( CTRL+S ).  
• Sačuvaj kao ( Save As ) čuvanje postojećeg dokumenta pod drugim imenom ili u drugi 

folder, može se koristiti takođe za čuvanje novog dokumenta ( snimanje u datoteku ).  
• Štampaj ( Print ) štampanje dokumenta na štampač ili u datoteku ( CTRL+P ) 
• Pošalji ( Send ) slanje dokumenta e-mailom, faxom… 
• Objavi (Publish) 
• Zatvori (Close) dokument 
• Izlaz ( Exit ) izlaz iz programa Word ( ujedno i zatvaranje programa ) ( ALT+F4 ) 
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OTVARANJE NOVOG DOKUMENTA 

 
Novi dokument u Microsoft Wordu 2007 -u otvaramo na dva načina: 

1. Samim pokretanjem Microsoft Worda otvaramo novi prazan dokument 

2. U slučaju da već imamo pokrenut program MS Word, pomoću Standardne alatne trake 

klikom na dugme => Novi prazni dokument  

3. Kliknemo na dugme =>   => Novi, gdje nam se potom otvara dijaloški okvir Novi 
dokument u desnom dijelu prozora Worda gdje izaberemo klikom na riječ Prazan dokument .  
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OTVARANJE POSTOJEĆEG DOKUMENTA 

Dokument koji se već nalazi na disku ( CD mediju ili disketi ) možemo otvoriti: 

Kliknemo na dugme =>  => Otvori. 

 

U ovom slučaja pojavi se dijaloški okvir u kojem biramo dokument koji ćemo otvoriti. Prvo je 
potrebno otvoriti folder u kojoj se dokument nalazi. Glavni folder u Word-u je Moji Dokumenti 
My Documents koji sadrži foldere nižeg nivoa (mi sami kreiramo foldere nižeg nivoa prema 
vlastitim potrebama i dajemo im ime.) 

Folder nižeg nivoa otvorimo tako da dva puta kliknemo na njegovo ime ili ikonu, ili da jedanput 
kliknemo na ime foldera da se ono označi a zatim na dugme => Otvori. Nakon klika na ovo 
dugme pojaviće se dijalog prozor pod nazivom Otvaranje. Klikom na lijevom meniju biramo 
gdje ćemo pronaći datoteku koju želimo otvoriti. 

Zadatak 1      
(PRIPREMNI TEST ZA 
POLAGANJE MODULA)
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Pojavljuje se spisak dokumenata u toj mapi i mi otvaramo željeni dokument dvostrukim klikom 
na njegovo ime ili jedanput kliknemo na ime dokumenta da ga označimo, a zatim na dugme => 
Otvori. ( na slici gore, blijedosivo označen ). 

Dokument možemo otvoriti i tako da u dijaloškom prozoru u prostor Naziv datoteke upišemo 
ime dokumenta i zatim pritisnemo tipku Enter ili kliknemo na dugme  => Open. 

 

OTVARANJE VIŠE DOKUMENATA ODJEDNOM 

 
Korištenjem naredbe Open moguće je otvoriti više dokumenata odjednom. Kada otvorimo 
potrebnu folder, više dokumenata označimo tako da kliknemo na prvi dokument, držimo 
pritisnutu tipku Shift a pomoću tipki sa strelicama označavamo dokumente koje želimo otvoriti.  
 
Drugi način je da držimo pritisnutu tipku Shift, a zatim kliknemo na prvi i posljednji dokument u 
nizu koje želimo otvoriti. Time označimo sve željene dokumente. 
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Ako dokumenti koje želimo otvoriti nisu u nizu, tada držimo pritisnutu tipku Ctrl i kliknemo na 
svaki dokument koji želimo otvoriti. Kada označimo sve potrebne dokumente, kliknemo na 
dugme => Open. 

Svi označeni dokumenti se otvore jedan za drugim. 

Postojeći dokument u Microsoft Word-u 2007 moguće je otvoriti i preko Windows Explorera 
(ikone Moji Dokumenti ) tako da dva puta kliknemo na ime dokumenta. Automatski se pokreće 
program Microsoft Word 2007 i učita traženi dokument u memoriju sistema. 

MEMORISANJE ILI ČUVANJE DOKUMENTA  

Čuvanje dokumenta vršimo pomoću naredbe Save, a nju možemo pokrenuti klikom na dugme 

Save  na  alatnoj traci, klikom na dugme  naredba Save ili kombinacijom tipki na tastaturi 
Crtl+S. 
  
Pojavi se dijaloški okvir "Save as" pomoću kojeg određujemo folder u koji ćemo sačuvati 
dokument, ime dokumenta i tip dokumenta. 
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U dijalog polju "Save in" nalazi se ime foldera u koji ćemo sačuvati dokument. Izvorno je 
podešen folder Moji Dokumenti ( My Documents ), ali možemo odrediti bilo koju drugu mapu 
na disku tako da je otvorimo dvostrukim klikom na njeno ime ili ikonu. Isto tako sa padajućeg 
menija možemo izabrati folder ili particiju na koju želimo snimiti datoteku ( dokument ) Ako 
smo već sačuvali  neki dokument, Microsoft Word 2007 će u polju "Save in" automatski 
ponuditi ime foldera u koji smo sačuvali prethodni dokument. 

U polju "File name" dodjeljujemo dokumentu ime prema želji. 

U polju "Save as type" određujemo format dokumenta. Microsoft Word 2007 automatski nudi 
Wordov dokument (*.docx), ali se može izabrati i neki drugi format što zavisi o potrebama 
korisnika. U ovom polju možemo sačuvati dokument u ranijim verzijama Microsoft Worda 2007, 
ako za to postoji potreba. 

 

ČUVANJE DOKUMENTA POD DRUGIM IMENOM 

Želimo li već sačuvan dokument ponovo sačuvati  pod drugim imenom ili u drugi folder, 

pokrenut ćemo naredbu   => Save as 

Pokretanjem ove naredbe pojavljuje se isti dijaloški okvir Save as. U njemu odredimo promjene 
koje želimo, promijenimo folder, ime ili format dokumenta i kliknemo na dugme Save. 

 

ZATVARANJE DOKUMENTA  

 
Dokument možemo zatvoriti na nekoliko načina: 

1. Preko menija naredba sa tekstualnog menija  => Close. 

Zadatak 1      
(PRIPREMNI TEST ZA 
POLAGANJE MODULA)
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2. Klikom na dugme sasvim desno na traci s izbornicima. 

Ako želimo zatvoriti dokument a da nismo sačuvali nikakve promjene, Microsoft Word 2007 će 
nas upozoriti "Želite li sačuvati promjene koje ste napravili u dokumentu?". 

 

 

Tada je potrebno izabrati opciju  

Da (Yes)         => zatvori dokument i sačuvaj promjene 

Ne  (No)          => zatvori dokument ali nemoj sačuvati promjene 
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Odustani (Cancel)  => odustani od izlaza iz dokumenta i vrati se nazad, želim još nešto raditi u 
dokumentu. 

 

PREGLED DOKUMENTA PRIJE ŠTAMPANJA 

 
Prije nego što dokument ispišemo na papir, možemo pogledati i provjeriti njegov izgled na 

ekranu pomoću dugmeta Print Preview  ili preko dugmeta  => Print =>Print Preview 

U oba slučaja izgled ekrana se promijeni. Na vrhu se vidi samo tab sa ispisom Print Preview I 
grupe za podešavanje dokumenta. 

 

Pomoću alatne trake Print Preview možemo vršiti određene korekcije na dokumentu. Možemo 
podešavati margine dokumenta preko lenjira, možemo premještati slike  unutar dokumenta ili 
pogledati nekoliko stranica dokumenta odjednom na ekranu. 

Dokument na ekranu izgleda onako kako će se izštampati na papiru. Štampu dokumenta možemo 
pokrenuti direktno klikom na dugme Print na traci ili  tako da zatvorimo alatnu traku Print 

Preview, a zatim pokrenemo dugme   => Print. 

AKO IMATE VIŠKA LISTOVA NA KRAJU ? 

Ako ste završili dokument i imate viška listova na kraju dokumenta a želite ih obrisati uradite 
slijedeće: 

1. Postavite kursor na kraj zadnje stranice pa pritisnite tipku DELETE ( DEL ) i držite je 
dok ne nestanu stranice viška (ili selektirajte te stranice viška pa opet (DEL) 

2. Ako ste imali ručni prijelom stranice izbrišite taj ručni prijelom. 
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ŠTAMPANJE  DOKUMENTA 

Ako želimo štampati cijeli dokument u više primjeraka ili samo dio dokumenta (nekoliko 

stranica), upotrijebit ćemo naredbu  => Print ili pritisnuti kombinaciju tipki CTRL+P. 

Klikom na  => Print pojavi se dijaloški okvir Print u kojem određujemo sljedeće: 

 

1. U polju Printer određujemo ime štampača (štampač koji je instaliran na računar ili je u 
mreži. Klikom na padajući meni mijenjamo štampač na koji želimo ištampati dokument), 
a klikom na dugme Properties možemo podesiti rezoluciju štampe, kao i druge 
parametre (klikom na ovo dugme otvara nam se novi dijalog prozor). 

2. U polju Page range biramo stranice za štampu, Sve stranice jednog dokumenta,  samo 
Trenutnu stranicu (onu na kojoj se nalazi kursor) ili samo određene Stranice  (tada je u to 
polje potrebno upisati koje stranice želimo štampati). npr: Ako želimo štampati slijedeće 
stranice: prvu, petu, sedmu do dvanaestu i četrnaestu, upišemo brojke na slijedeći 
način : 1,5,7-12,14 

Zadatak 26      
(PRIPREMNI TEST ZA 
POLAGANJE MODULA)
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3. U polju Copies određujemo broj kopija štampe i način štampanja kopija. Ako je 
uključena opcija "Collate", tada će se kopije ispisivati na način da se sve stranice ispišu u 
jednom primjerku, zatim u drugom, trećem itd. Ako je ova opcija isključena, tada će se 
prva stranica štampati u zadanom broju kopija, nakon nje druga, pa treća itd. (takođe se 
prikaže grafički prikaz redoslijeda štampe) 

4. U polju Print možemo izabratištampanje samo parnih, samo neparnih ili svih stranica 
dokumenta. Ovo je korisno ako želimo štampati dokument na obje strane papira a 
nemamo štampač koji može raditi u DUPLEX formatu. Tada prvo ispišemo neparne 
stranice, složimo papire ponovo u štampač, a zatim ponovimo štampanje parnih stranica. 

5. U polju Zoom nude se dvije opcije. Opcija Stranica po listu nudi nam mogućnost da na 
jednom listu papira ištampamo više stranica jednog dokumenta (do 16), što omogućava 
veću preglednost dokumenta, kontrolu štampe i uštedu papira. Pri tom Microsoft Word 
2007 proporcionalno smanji izgled stranice zavisno broju izabranih stranica po jednom 
listu papira. Opcija Scale to paper size na vel. stranice omogućava ispis stranice na veći 
ili manji format od zadanog ( A4 ).  

6. Kada podesimo sve opcije kliknemo na dugme OK i pošaljemo dokument na štampu. 

 

KREIRANJE FOLDERA  

Nove foldere možemo kreirati u operativnom sistemu Windows ili u samom Microsoft Wordu 
2007.  
Novi folder u Microsoft Wordu 2007 možemo kreirati u dijaloškom prozoru naredbi Open, Save 
i Save as iz tekstualnog menija Datoteka. 

U ovim dijaloškim prozorima ispod naslovne trake nalazi se dugme Create new folder. 

Dijaloški prozor Save as 
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Dijaloški prozor Open ( Otvaranje ) 

 

Klikom na dugme "Create new folder" otvara se dijaloški prozor New folder u kojem 
određujemo ime novom folderu. Pri tome treba imati na umu gdje će se nalaziti folder koji 
želimo kreirati. Ako će to biti folder unutar nekog drugog foldera, tada je potrebno prvo otvoriti 
onaj folder unutar kojeg želimo kreirati novi u primjeru na slici novi folder će se nalaziti unutar 
foldera My documents tj. bit će folder  nižeg nivoa u folderu  New folder.  
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U ovom slučaju na gornjoj slici vidimo gdje će se kreirati novi folder kada kliknemo na dugme 
"Create new folder". To se vidi u polju "Look in" u desnom gornjem uglu slike. Upišemo naziv 
novog foldera i potvrdimo na dugme  "OK" 

Kada bi smo željeli kreirati Novi folder na Radnoj površini (desktopu) bilo bi dovoljno kliknuti 
na dugme-ikonu Desktop koja se nalazi na lijevoj strani prozora u meniju a potom kreirati novi 
folder ( New folder ili New Directory ). 
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KRETANJE PO DOKUMENTU  

Po dokumentu se možemo kretati upotrebom tastature i upotrebom miša. 

 
Kretanje po dokumentu pomoću tastature 

1. Upotreba lijeve strelice pomiče nas za jedan znak lijevo, odnosno, desna strelica u 
desno  
 
2. Upotreba strelice prema gore pomiče nas za jedan red gore, a strelica prema dolje 
jedan red dolje. 
 

3. Kombinacija tipki + pomiče nas za jednu riječ lijevo, a  + za jednu riječ 
desno. 
 

4. Kombinacija tipki + pomiče nas za jedan odlomak gore, odnosno + za 
jedan odlomak dolje u dokumentu.                               
 
5. Tipka Page Up pomiče nas za jedan izgled ekrana prema gore. 
 
6. Tipka Page Down pomiče nas za jedan izgled ekrana prema dolje. 
 
7. Tipka Home postavlja nas na početak reda u kojem se nalazi kursor. 
 
8. Tipka End postavlja nas na kraj reda u kojem se nalazi kursor. 
 
9. Kombinacijom tipki Ctrl+Home dolazimo na početak dokumenta. 
 
10. Kombinacijom tipki Ctrl+End dolazimo na kraj dokumenta. 
 
Kretanje po dokumentu upotrebom miša  
 
1. Pomoću klizne trake (nalazi se s desne strane radne površine) krećemo se po dokumentu 
okomito prema gore ili prema dolje. Pritisnemo lijevu tipku miša i vučemo klizač prema gore ili 
prema dolje do željenog mjesta u  dokumentu, i tada otpustimo tipku miša.  
 
2. Klikom na strelicu klizne trake okrenutu vrhom prema gore, odnosno prema dolje krećemo se 
jedan red gore, odnosno dolje po dokumentu. 
 
3. Klikom na dvostruku strelicu okrenutu vrhom prema dolje pomičemo se na sljedeću stranicu, a 
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klikom na dvostruku strelicu okrenutu vrhom prema gore na prethodnu. 
 
4. Pomoću klizne trake za vodoravni pomak, krećemo se lijevo, odnosno desno po dokumentu 
tako da lijevom tipkom miša vučemo klizač u željenom smjeru. 
 
5. Pomoću strelice klizne trake za vodoravni pomak okrenute vrhom lijevo, pomičemo se za 
jedan stupac Tab-a lijevo, a klikom na strelicu okrenutu vrhom u desno, ili pomičemo se za jedan 
stupac Tab-a udesno. 

6. Klikom triput na određeno mjesto (bjanko dokument) na dokumentu ako nema teksta, tj. ako 
kursor nije prošao i ostavio trag za upis znaka (slova). 

 

TASTATURA SA RASPOREDOM TIPKI 

 

 

KLIZNE TRAKE U WORDU 
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OZNAČAVANJE (selektovanje) TEKSTA 

 
Da bismo mogli izvršiti bilo kakvu promjenu u dokumentu na tekstu, prvo moramo označiti dio 
dokumenta (teksta) na kojem želimo tu promjenu izvršiti. 

Pod označenim (selektiranim) tekstom podrazumijeva se tekst ispisan bijelim slovima na crnoj 
pozadini (osjenčeni tekst). 

Tekst se označava tako da na početak teksta postavimo pokazivač miša, pritisnemo lijevu tipku 
miša i držeći pritisnutu lijevu tipku vučemo miš preko cijelog teksta koji želimo označiti.  
 
Kada dođemo na kraj teksta koji želimo označiti, otpustimo lijevu tipku miša. Tekst koji smo 
označili mora biti ispisan bijelim slovima na crnoj pozadini. 

1. Tekst možemo označiti pomoću tipke Shift tako da kliknemo na početak teksta kojeg želimo 
označiti, držimo pritisnutom, tipku Shift, a zatim pritišćemo tipke sa strelicama i pomičemo se 
po dokumentu u onom smjeru u kojem želimo označiti  tekst.  

2. Tekst možemo označiti i tako da kliknemo na početak dijela koji želimo označiti, zatim 
pritisnemo tipku Shift i kliknemo na kraj teksta koji želimo označiti. Time označimo čitav blok.  
 
3. Želimo li označiti samo jednu riječ, dovoljno je dva puta brzo kliknuti na nju.  
 
4. Želimo li označiti red, postavimo pokazivač miša lijevo od tog reda da promijeni  izgled u 
strelicu nagnutu na desnu stranu i kliknemo jednom lijevom tipkom miša. Time označimo čitav 
red. Držimo li pritisnutu lijevu tipku miša i vučemo li miša okomito prema gore ili dolje, 
označavati ćemo red po red u dokumentu. 

5. Želimo li označiti čitav odlomak, potrebno je tri puta kliknuti lijevom tipkom miša unutar 
tog odlomka. 

6. Želimo li označiti rečenicu, pritisnut ćemo tipku Ctrl i kliknuti bilo gdje unutar rečenice. 
 
7. Želimo li označiti dio dokumenta u pravougaonom obliku (npr. kod tabela i sl.), pritisnemo 
tipku Alt, a zatim kliknemo mišem na početak dijela koji želimo označiti i razvučemo 
pravougaonik. Kako razvlačimo pravougaonik, tako označavamo tekst.  

8. Želimo li označiti čitav dokument, upotrijebit ćemo kombinaciju tipki Crtl+A ili ćemo 
kliknuti na meni Uređivanje => Označi sve. Cijeli dokument možemo označiti i tako da tri 
puta kliknemo mišem uz lijevu marginu dokumenta. 



Microsoft word 2007 

 

Fakultet za informacione tehnologije ‐ Univerzitet Mediteran |  30 

 

9. Označavanje ( bloka ) cjeline teksta 

To možete na slijedeći način:  

Postavite CURSOR (pokazivač za pisanje prvog znaka- slova) na mjesto odakle želite početi 
označavanje teksta, na slici označeno plavom bojom.  (označavanje bloka teksta) 

 

Sada pritisnite lijevu tipku ALT na tastaturi i zadržite je. Potom klikom lijevom tipkom miša na 
početak područja za obilježavanje (plavo) i vucite do dna bloka teksta koji želite obilježiti. Sada 
ste obilježili dio teksta u tzv. "blok" području i potrebno je desnom tipkom miša kliknuti i 
izabrati ( COPY ) KOPIRAJ, a potom ga zalijepiti gdje želimo. 
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BRISANJE TEKSTA  

 
Tekst možemo izbrisati na nekoliko načina: 

1. Tipka Backspace briše jedan znak lijevo od kursora, odnosno posljednji uneseni znak i 
pomjera sav tekst prema brisanim znakovima. Višestrukim pritiskom na tipku Backspace 
možemo izbrisati više znakova. 

  

 

2. Tipka Delete ( DEL ) briše jedan znak desno od kursora i povlači sav tekst prema sebi. 
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3. Da bi izbrisali veći dio teksta, prvo je potrebno tekst označiti, a zatim kliknuti na dugme 
CUT (CTRL+X) na Standardnoj alatnoj traci. Naredba CUT briše (izrezuje) označeni 
dio teksta iz dokumenta i čuva ga u memoriji. Klikom na dugme PASTE ( CTRL+V ), 
sadržaj memorije može se zalijepiti na isto ili neko drugo mjesto u dokumentu. 

4. Označeni dio teksta možemo izbrisati klikom na grupu na traci Home Clipboard => 
CUT (Izreži ili Očisti).  

 

5. Označeni dio teksta možemo izbrisati pritiskom na tipku Backspace, Delete ili pritiskom 
na razmaknicu 

 

NAREDBE PONIŠTI I PONOVI (UNDO i REDO)  

 
Naredba Poništi poništava našu zadnju radnju, odnosno vraća nas korak nazad i popravi 
učinjeno. 
 
Shvatimo li da smo pogriješili ( slučajno izbrisali dio teksta i sl. ), kliknemo na dugme  naredbe 
Poništi, čime ćemo ispraviti pogrešku. Naredbu Poništi  možemo upotrijebiti više puta 
uzastopno, ovisno o broju pogrešaka ili koliko se koraka nazad u uređivanju dokumenta želimo 
vratiti. 
 
Naredbu Ponovi (Redo) koristimo da bismo ponovili ono što smo naredbom Poništi (Undo) 
poništili. 
 
Naredbu Ponovi možemo aktivirati toliko puna uzastopno, koliko smo puta koristili naredbu 
Poništi. 
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Naredbe Poništi i Ponovi možemo pokrenuti i kombinacijom tipki Ctrl+Z (Poništi) ili Ctrl+Y 
(Ponovi) 

 

UMETANJE TEKSTA 

 
Umetanje, odnosno naknadno dopisivanje teksta vršimo tako da postavimo kursor na ono mjesto 
gdje želimo dopisati tekst i tekst jednostavno dopišemo. U tekst možemo umetnuti sadržaj 
drugog dokumenta korištenjem CLIPBOARD. 

Clipboard je dio memorije u kojem možete privremeno da čuvate tekst ili grafiku. Namjena 
Clipboard-a je da se u njemu privremeno smjesti tekst ili grafika kada želite da ga premjestite iz 
jednog u drugi dokument ili sa jednog na drugo mjesto u okviru istog dokumenta. 

 
 

1. Otvorimo dokument čiji sadržaj (ili dio) želimo umetnuti u drugi dokument. 

2. Označimo željeni tekst i kopiramo ga u memoriju pomoću naredbe  Kopiraj ( CTRL+C). 

Zadatak 5      
(PRIPREMNI TEST ZA 
POLAGANJE MODULA)
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3. Premjestimo se u dokument u koji ćemo umetnuti sadržaj CLIPBOARD. 

4. Postavimo kursor na željeno mjesto u dokumentu i kliknemo na dugme naredbe Zalijepi 
(PASTE(CTRL+V ) . 

 

SAVJET: zadnji upisan tekst možete ponavljati u nedogled pritiskom na tipku F4 ( nakon upisa 
teksta ). 

 

PREMJEŠTANJE TEKSTA 

  
 
Tekst možemo premještati povlačenjem miša na sljedeći način: 

1. Označimo dio teksta koji želimo premjestiti (vidi poglavlje Označavanje teksta) 
 
2. Kliknemo na označeni dio teksta lijevom tipkom miša i držimo je pritisnutom. 
 
3. Kada se na kraju strelice pojavi kvadratić, povučemo strelicu ( miša ) na mjesto gdje želimo 
tekst premjestiti i otpustimo tipku miša. 

 

Na ovaj način možemo premještati riječi ili čitave rečenice (odlomke) unutar jednog dokumenta. 
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Označeni dio dokumenta (teksta, tablica, slika itd)  možemo premjestiti povlačenjem desnom 
tipkom miša. U tom se slučaju, kada otpustimo desnu tipku miša na željenom mjestu, pojavi 
meni s naredbama. Kliknemo na naredbu PASTE. 

 

Drugi način premještanja teksta je korištenjem naredbi CUT (Izreži) i PASTE (Zalijepi) na 
sljedeći način: 

1. Označimo dio teksta koji želimo premjestiti 

2. Kliknemo na dugme Izreži ( Cut ) ili kliknemo na meni Uređivanje naredba  Izreži ( Ctrl+X ) 
– pri tom se označeni dio teksta izbriše i privremeno sačuva u clipboard. 

3. Postavimo kursor na mjesto gdje želimo premjestiti tekst 

4. Kliknemo na dugme Zalijepi ( Paste ) ili ( Ctrl+V ). 
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KOPIRANJE TEKSTA  

 
Tekst možemo kopirati unutar jednog dokumenta, iz jednog dokumenta u drugi i iz jednog 
programa u drugi (npr. proračunske tabele iz Excela u Word). 

Kopiranje teksta vršimo pomoću naredbi Kopiraj (COPY) i Zalijepi (PASTE) na sljedeći 
način: 
 
1. Označimo dio teksta koji želimo kopirati. 

2. Naredbom Kopiraj (COPY)  kopiramo označeni tekst u clipboard. 

3. Postavimo kursor na mjesto gdje želimo tekst kopirati (u istom dokumentu ili otvorimo drugi 
dokument ili program). 

4. Naredbom Zalijepi (PASTE) umetnemo tekst iz clipboard u dokument. 

Želimo li dio teksta kopirati unutar istog dokumenta, to možemo učiniti i tako da označimo tekst, 
pritisnemo tipku Ctrl, a zatim mišem odvučemo označeni tekst na ono mjesto u dokumentu na 
koje ga želimo kopirati. Prvo otpustimo tipku miša a zatim tipku Ctrl. Prilikom povlačenja 
teksta, miš će imati oblik strelice ispod koje se nalazi znak "+" (oznaka da se tekst kopira). 
Označeni tekst možemo kopirati i tako da ga desnom tipkom miša odvučemo na željeno mjesto, 
a kada otpustimo tipku miša, pojavi se meni u kojem kliknemo na naredbu Kopiraj ovdje (Copy 
Here). 

 

FUSNOTE U MICROSOFT WORD-u 2007  

Fusnote u dokument unosimo na sljedeći način: 

1. Postavimo kursor na mjesto gdje želimo unijeti fusnotu. 

2. Kliknemo na meni Insert naredba References=> Insert Footnote.  
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Ukucamo fusnotu. Klikom na donji desni ugao grupe Footnotes pojaviće  se dijaloški okvir u 
kojem biramo želimo li fusnotu ili krajnju bilješku, i izaberemo vrstu Oblika broja fusnote. 
Opcija Oblik broja omogućava automatsko dodjeljivanje brojeva fusnotama od 1 na dalje. 
Klikom na dugme Simbol možemo podesiti simbol za fusnotu  itd. 

 

Kao korisničku oznaku za numeriranje fusnoti možemo upisati zvjezdicu, znak uzvika ili izabrati 
neki simbol klikom na dugme Symbol. 

3. Kada izaberemo sve opcije, kliknemo nadugme Insert. 

4. Na dnu stranice pojavi se oznaka fusnote pored koje upišemo sadržaj. 
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5. Kad završimo s upisivanjem sadržaja fusnote kliknemo bilo gdje na radnu površinu u 
dokumentu. 
 
6. Na mjestu koje smo odredili pojavi se oznaka fusnote, a na dnu stranice sadržaj koji smo 
napisali. 
 
Tekst fusnota uređuje se na isti način kao i tekst u dokumentu.  

Premještanje fusnota: označimo oznaku (broj ) fusnote u dokumentu i Odvučemo je mišem na 
drugo mjesto. 

Dopisivanje sadržaja u fusnote: postavimo kursor na ono mjesto u sadržaju fusnote gdje 
želimo dopisati tekst i tekst jednostavno dopišemo. 

Brisanje sadržaja fusnote: označimo tekst u sadržaju fusnote i obrišemo pomoću tipke Delete, 
Backspace ili klikom na dugme Izreži (CUT). 

Brisanje fusnota: označimo broj  fusnote i izbrišemo je pomoću tipke Delete, Backspace ili 
klikom na dugme  Izreži (CUT) (time istovremeno izbrišemo broj i sadržaj fusnote. 

 

NABRAJANJE STAVKI I PODNASLOVA U TEKSTU  

 
Vršimo li u tekstu određena nabrajanja (nabrajanja stavki, podnaslova i sl.), postoji potreba da se 
taj dio teksta posebno istakne. Osim nabrajanja stavki možemo poželjeti određene odlomke u 
tekstu označiti grafičkom oznakom. 

Želimo li tekst da nabrajamo bojevima 1, 2 itd. kliknemo na dugme Numerisanje (numbering) 
na grafičku oznaku na alatnoj traci Oblikovanje (bullets), a ako želimo nabrajanje istaknuti 
tačkicama ili zvjezdicama, kliknemo na grafičku oznaku na alatnoj traci Oblikovanje.  

Zadatak 10      
(PRIPREMNI TEST ZA 
POLAGANJE MODULA)
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Na kartici Grafičke oznake (kao i na kartici numeričke oznake) biramo vrstu grafičkih oznaka 
kojima želimo označiti  odlomak ili nabrajati tekst. Grafičku oznaku biramo tako da označimo 
kvadratić s oznakom, a zatim kliknemo na dugme OK. 

Grafičke oznake možemo prilagoditi prema želji. Označimo kvadratić sa znakom koji  želimo 
zamijeniti i kliknemo na dugme Define New Bullet. Pojavi se novi dijaloški okvir Define New 
Bullet s grafičkim oznakama u kojem možemo izabrati jedan od ponuđenih znakova. Označimo 
znak koji želimo i kliknemo na dugme OK. Sada se izabrani znak nalazi na kartici Grafičke 
oznake. A ima tu i još opcija. 

Ako nas ni jedan znak u dijaloškom okviru Define New Bullet s grafičkim oznakama ne 
zadovoljava, tada kliknemo na dugme Symbol… oznaka i u dijaloškom okviru izaberemo bilo 
koji znak. Odabir znaka potrebno je potvrditi klikom na dugme OK. 

Osim grafičkih znakova možemo koristiti i slike. Kliknemo na dugme Picture… i pojavi se 
dijaloški okvir Grafička oznaka – slika u kojem možemo izabrati jednu od ponuđenih slika ( pri 
tom se CD Office 2007 mora nalaziti u zato predviđenoj jedinici jer se slike po odabiru učitaju s 
CD-a ili idemo na internet i potražimo sliku). Ako želimo izabrati sliku iz vlastite datoteke, 
kliknemo na dugme. Import i izaberemo sliku. Izbor potvrdimo klikom na dugme OK. 

Na kartici Number Library možemo izabrani način nabrajanja brojevima, tako da označimo 
način numerisanja.  

 

UMETANJE SLIKE U DOKUMENT  

1. Postavimo tačku unosa gdje želimo umetnuti sliku. 
2. Kliknemo na traku Insert => Picture, Clip Art, Shapes, Smart Art, Chart a potom 

izaberemo odakle ćemo umetnuti sliku. 

Zadatak 3      
(PRIPREMNI TEST ZA 
POLAGANJE MODULA)
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3. Pojavi se podmeni u kojem možemo birati Isječak crteža  iz Clip Arta (slike koje su 
sastavni dio paketa Microsoft Office), ili sliku koju smo sami kreirali Iz datoteke. A 
takođe  iz drugih izvora koji su ponuđeni. Zavisno od izbora, pojaviće se dijaloški okvir:   
 
a) Izaberemo li Oblike (Shapes), možemo birati mnoštvo oblika (linija, strelica, kocka 
pravougaonik itd..) .Klikom na željeni oblik dobijamo taj oblik na dokumentu. 

4. Brisanje slika  Označimo oblik, a zatim pritisnemo tipku Delete ili Backspace, odnosno 
kliknemo na dugme Izreži ( Cut ). 

 

 

Na donjoj slici se vidi kompletana traka za podešavanje slike koja je predhodno umetnuta u 
dokument. 
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Kada ste umetnuli sliku u dokument Worda, istu možete pozicionirati na više načina. 

Prvi način je kreirati tabelu i sliku postaviti u jednu od ćelija a tekst pored u drugu ćeliju 
Drugi način je umetnuti sliku u dokument a potom oblikovati poziciju slike pomoću alatne trake 
(plivajućeg menija) "Slika" 

Slika ispod prikazuje umetnutu sliku u dokument koja je postavljena između teksta pomoću 
plivajućeg menija naredbe "U ravnini s tekstom" kada je aktivan plivajući meni. 

 

Slika ispod prikazuje oblikovanje umetnute slike direktno pomoću desne tipke miša na sliku. 
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Slika ispod prikazuje otvoren dijalog prozor za oblikovanje slike sa karticom "Izgled", na kojem 
vidimo pet mogućnosti postavljanja slike između teksta, u ovom slučaju je to postavljanje slike 
ispod teksta. 

 

 

UPOTREBA TEKSTNIH OKVIRA U DOKUMENTU ( tekstni okviri ) 

Tekstualni okrivi su okviri koji sadrže određeni tekst. Kako mogu biti različite veličine i boje, 
služe za isticanje sadržaja dokumenta. 

Tekstualni okvir možemo kreirati tako da ga prvo nacrtamo, a zatim unosimo tekst ili da već 
napisan tekst uokvirimo. Ako imamo napisan tekst koji želimo smjestiti u okvir, tada tekst 
označimo, a zatim kliknemo na meni Umetanje  (Insert) => Tekstualni okvir (Texs Box). 
Označeni dio teksta se pojavi u okviru koji je potrebno dalje urediti. 

 

Želimo li prvo nacrtati okvir, a zatim unijeti tekst, kliknut ćemo na dugme Tekstualnog okvira 
na traci Format na traci za crtanje.U ovom slučaja pokazivač miša promijeni oblik u krstić. Sada 
pritisnutom lijevom tipkom miša crtamo oblik i veličinu okvira prema želji. Nakon tog unosimo 
tekst. 

        Ovdje se unosi određeni tekst 
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Uređivanje Tekstualnih okvira 

 
 
 
Sadržaj Tekstualnog okvira uređuje se na isti način kao i svaki drugi tekst u dokumentu, bilo 
korištenjem dijaloškog okvira Font ili na alatnoj traci Format (stilovi ,sijenke,3d efekti,itd.). 

Promjena veličine Tekstualnog okvira pomoću miša: označimo Tekstualni okvir, a zatim 
pomoću označenih kvadratića na uglovima i stranicama okvira razvlačimo ili suzimo okvir 
dijagonalno, prema gore ili prema dolje. 
Premještanje Tekstualnog okvira: označimo okvir i vučemo ga mišem na željeno mjesto. 
Brisanje Tekstualnog okvira: označimo okvir i pritisnemo tipku Delete ili kliknemo na dugme 
Izreži (CUT). 

 

OBLIKOVANJE FONTA U DOKUMENTU 

 Tekst koji želimo oblikovati, moramo prethodno označiti.  

Font možemo oblikovati pomoću taba Home na alatnoj traci Font. Klikom na dugme na alatnoj 
traci Font možemo mijenjati Font (slova - pismo), veličinu fonta, podebljati, ispisati kurzivom 
ili podcrtati font i promijeniti boju fonta. 

Kliknemo li na meni Font CTRL+Shift+F pojavi se dijaloški okvir Font u kojem možemo 
birati više mogućnosti.U polju Font: biramo vrstu fonta klikom na pojedino ime s liste, a u 
prozorčiću Pregled vidimo kako pojedini font izgleda. 

U polju Stil fonta biramo stil koji želimo: običan, kurziv, podebljano ili podebljano kurziv. 
 
U polju Veličina: biramo veličinu fonta klikom na brojčanu vrijednost. Želimo li neparnu 
vrijednost veličine fonta, tada izbrišemo broj u polju Veličina i upišemo željeni broj. Zatim 
kliknemo na dugme U redu (OK) ili pritisnemo tipku Enter. 

U polju Boja fonta (Font color) biramo boju fonta. Kliknemo na dugme sa strelicom pored polja, 
a zatim izaberemo jednu od ponuđenih boja ili kliknemo na Više boja za izbor sa palete boja, a u 
dijaloškom okviru Boje biramo boju ili njen intenzitet na kartici Korisnički.  

Zadatak 12,13      
(PRIPREMNI TEST ZA 
POLAGANJE MODULA)
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U polju Stil podcrtavanja biramo način podcrtavanja (jednostruka crta, valovima, podcrtavanje 
samo riječi itd.), a u polju Boja podcrtavanja biramo boju. 

U polju Efekti: biramo efekte kao što su precrtavanje riječi jednom ili dvostrukom crtom, 
dodavanje sjena, samo konture slova itd. Kada izaberemo sve što želimo, kliknemo na dugme U 
redu. 

 

Ako kliknete na dugme  Default  onda Vam se pojavi ovaj dijaloški okvir. Ako potvrdite ta će 
promjena biti primjenjena na sve nove dokumente. 
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PROŠIRENI I ZGUSNUTI ISPIS U DOKUMENTU  

Kada se pojavi potreba za proširenim ili zgusnutim ispisom cijelog ili samo dijela teksta, 
potrebno je učiniti sljedeće: 

1. Označiti tekst. 

2. Kliknuti na tab Home zatim na strelicu u desnom donjem uglu trake Font. 

 
 
 

3. U dijaloškom okviru Font kliknuti na karticu Razmak među znakovima (Character 
Spacing). 

4. U polju Spacing izabrati vrstu ispisa (obično, prošireno ili zgusnuto).  

5. Izbor potvrditi klikom na dugme Ok.. 

U polju Position možemo birati spušteni ili povišeni položaj označenog znaka ili riječi u odnosu 
na red. Pri tome sami određujemo vrijednost u polju s desne strane. 
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Ako kliknete na dugme Default  onda Vam se pojavi ovaj dijaloški okvir. Ako potvrdite ta će 
promjena biti primjenjena na sve nove dokumente. 

 

 

PISANJE INDEXA I EXPONENTA  U DOKUMENTU  

Prilikom pisanja teksta često se javlja potreba za pisanjem matematičkih ili kemijskih formula. 
Tom prilikom javlja se potreba za upotrebom indeksa i eksponenata. 

Indekse i eksponente određujemo u meniju Oblikovanje => Font  

Pisanje indeksa 

Primjer : pisanje kemijske formule za vodu H2O. 
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Napišemo H2O, označimo br. 2, kliknemo na Oblikovanje => Font i u dijaloškom okviru Font 
u polju Efekti potvrdimo opciju Indeks (kvačica mora biti uključena) tzv. "čekiranje" 
 
Kliknemo na dugme U redu ili pritisnemo tipku Enter. 

OVO je dijaloški okvir na kojem nije uključen INDEX 2 

 

OVO je dijaloški okvir na kojem jeste uključen INDEX  
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Obratite pažnju na veličinu broja 2 u odnosu na donju liniju sa obje strane broja 

Sada naš H2O izgleda ovako. 

 

Ako želite napisati neki EXPONETNT uradite slijedeće: 

Želimo napisati broj 3 na stepen dvanaest ili dvastepena na osam 

- Za prvi broj upišite normalno broj 312 
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- zatim selektujte brojeve 1 i 2 ( tj broj 12 ) 

- kliknite na strelicu u donjem desnom uglu karte Font i u dijaloškom okviru Font u polju Efekti 
potvrdimo opciju Eksponent (Superscript)(kvačica mora biti uključena) tzv. "čekiranje" 

- potvrdite klikom na dugme "OK" 

- Za drugi broj upišite normalno broj 28 

- potom selektujte broj 8 

- kliknite na strelicu u donjem desnom uglu karte Font i u dijaloškom okviru Font u polju Efekti 
potvrdimo opciju Eksponent (kvačica mora biti uključena) tzv. "čekiranje" 

Rezultat bi trebao biti ovakav 

 

Takođe smo ove radnje mogli odraditi i preko desnog taster miša 

- Selektujemo broj 2 zatim 1 klik na desni taster miša izaberemo Font i čekiramo 
subscript 
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RAZMAK IZMEĐU ODLOMAKA I REDOVA   

Razmak između odlomaka i redova određujemo u dijaloškom okviru Odlomak (Paragraf). 
 
Pod odlomkom ( PARAGRAF , PASUS ) se podrazumijeva tekst napisan prije pritiska na tipku 
Enter.  
 
Odlomak ne moramo posebno označiti da bismo u njemu izvršili neku promjenu, već je dovoljno 
da se kursor nalazi bilo gdje unutar odlomka. Naredba koju pokrenemo odnosit će se na cijeli 
odlomak. 
 
Klikom na meni Oblikovanje => Odlomak pojavi se dijaloški okvir Odlomak.  

Na kartici Uvlake i razmaci određujemo izgled odlomka. 

 

Razmak možemo odrediti ispred i iza odlomka tako da upišemo vrijednosti u za to predviđena 
polja ili da svakim klikom na strelicu okrenutu vrhom prema gore razmak povećamo za 6 
točkica, a klikom na strelicu prema dolje smanjimo. 

U prozoru Pretpregled(Preview) možemo pratiti sve promjene. Odlomak koji uređujemo je crne 
boje, dok su odlomci ispred i iza sive boje. 

Zadatak 8      
(PRIPREMNI TEST ZA 
POLAGANJE MODULA)
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U polju Prored (Line Spacing) biramo razmak među redovima u odlomku. Razmak može biti  
jednostruk, dvostruk, 1,5 linija, višestruk, a možemo odrediti točan razmak u točkicama i 
najmanji razmak među redovima.  

Prored možemo odrediti pomoću tastature kombinacijama tipki 

Crtl 1 – jednostruki prored 

Crtl 2 – dvostruki prored  

Crtl 5 – prored 1,5 linija 

POSTAVLJANJE ODREĐENOG RAZMAKA ZA TIPKU ENTER 

U koliko želite da Vam prilikom pritiska na tipku ENTER razmak između odlomaka (paragrafa – 
pasusa) bude veći nego što je to standardno postavljeno u Wordu, uradite slijedeće.  
 
1. Kliknemo na traku Home traka Paragraf zatim na desnu donja strelica  

2. U polju Razmak (space) postavite određeni razmak postavljanjem nekog broja. Npr: 24. polje 
Ispred (before) 
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Sada prilikom pritiska na tipku Enter imate razmak između odlomaka veći nego što je to 
uobičajeno. 

UVLAČENJE REDOVA I ODLOMAKA   

Uvlačenjem redova i odlomaka postižemo različit izgled dokumenta, a pojedine odlomke time 
možemo posebno naglasiti. 

Odlomke možemo uvlačiti pomoću lenjira i miša, pomoću dugmeta na alatnoj traci Oblikovanje 
i određivanjem vrijednosti uvlaka u dijaloškom okviru Odlomak.  

Pomoću lenjira i miša 

Označimo odlomak (postavimo kursor u odlomak koji želimo uvući ili označimo više odlomaka) 
i povučemo uvlaku po lenjiru na željeno mjesto Kada otpustimo lijevu tipku miša, odlomak će se 
uvući na mjesto gdje je na lenjiru postavljena uvlaka. 

 

Pomoću alatne trake Oblikovanje  

Označimo odlomak (ili više njih) i kliknemo na dugme za povećanje ili smanjenje uvlake na 
alatnoj traci Oblikovanje. 

Zadatak 9      
(PRIPREMNI TEST ZA 
POLAGANJE MODULA)
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Pomoću dijaloškog okvira Odlomak 

 
 
Označimo odlomak ili više njih, kliknemo desni klik miša meni Paragraf.  
U dijaloškom okviru Odlomak u polju Uvlačenje (Indention) odredimo vrijednosti uvlačenja s 
lijeve i desne strane odlomka. Pri tom se uvlače cijeli odlomci. Želimo li uvući samo prvi red u 
odlomku, tada u polju Specijalno izaberemo opciju "First line". 

Ako želimo uvući sve redove odlomka osim prvog, tada izaberemo opciju "Hanging". 

 

Sada naš odlomak izgleda ovako 
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PORAVNANJE ODLOMAKA  U DOKUMENTU 

 
Postoje četiri vrste poravnanja odlomka: 

1. Lijevo – poravnanje uz lijevu marginu dokumenta 

2. Centrirano (Sredina) – poravnanje prema sredini između dviju margina dokumenta 

3. Desno – poravnanje uz desnu marginu dokumenta 

4. Obostrano (Poravnanje) – tekst je poravnat uz lijevu i desnu marginu dokumenta. 

Poravnanje preko alatne trake Paragraf vrši se tako da se klikne na dugme za određenu vrstu 
poravnanja (dugme mora biti osvijetljeno i utisnutu traku). Poravnanje će se primijeniti na 
odlomak u kojem se nalazi kursor ili na označeni dio teksta (više odlomaka ili čitav dokument). 
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Poravnanje pomoću dijaloškog okvira kliknemo na strelicu u desnom donjem uglu trake 
Paragraf a zatim u polju Poravnanje odredimo vrstu poravnanja (desno) i potvrdimo izbor 
klikom na dugme U redu ili pritiskom na tipku Enter. 

 

Odredimo vrstu poravnanja klikom na dugme ( lijevo, centralno, desno i obostrano). 

 

OKVIR I SJENČENJE ODLOMAKA  U DOKUMENTU  

Želimo li pojedine odlomke posebno naglasiti, možemo ih uokviriti crtama različitog izgleda i 
debljine. 

 
 

Zadatak 16      
(PRIPREMNI TEST ZA 
POLAGANJE MODULA)
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Na traci Paragraf na kartici Borders and Shading biramo okvir: 

1. U polju Settings- biramo način okvira (okvir, okvir sa sjenkom, trodimenzionalni okvir ili 
prema želji – Prilagodi). 

2. U polju Style– vrstu rubova (puna crta, isprekidana crta, dvostruka crta itd.). 

3. U polju Color– boju izabranog stila okvira. 

4. U polju Width – širinu (debljinu) izabranog stila okvira. 

U polju Preview mogu se vidjeti sve opcije koje smo izabrali. Ako smo u polju Settings izabrali 
Ništa, a izaberemo stil, boju i širinu, pomoću dugmeta u polju Preview možemo označenom 
odlomku dodati sve okvire, ili samo određene rubove (npr. samo s lijeve i desne strane). 

Klikom na dugme Options… možemo precizno odrediti razmak između okvira i teksta odlomka. 

Želimo li određenom odlomku dodati poseban efekt, možemo ga podvući posebnom 
vodoravnom crtom zatim izaberemo jednu od ponuđenih mogućnosti. Nakon što označimo 
željeni dizajn vodoravne crte, kliknemo na dugme OK. 

Vodoravna crta se pojavi ispod reda u kojem se nalazio kursor. Ako je označen cijeli odlomak, 
tada će se izbrisati označeni odlomak a na njegovu mjestu pojaviti izabrana crta. 

 

 

Na kartici Page borders možemo uokviriti čitavu stranicu na isti način kao i odlomak. 

Na kartici Shading određujemo pozadinu odlomka bojom ili uzorkom. 

U polju Fill biramo boju pozadine odlomka na način da kliknemo na željenu boju ili kliknemo na 
dugme More Colors…, gdje dalje biramo boju i njen intenzitet. 

U polju Patterns biramo intenzitete boje u postocima i uzorke, a u polju Boja, biramo boju 
izabranog intenziteta ili uzorka. 
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PODEŠAVANJE TOKA TEKSTA U ODLOMKU   

U radu s dokumentima događa se da prvi red u odlomku bude na jednoj strani, a ostatak odlomka 
na drugoj, ili da nam posljednji red u odlomku pređe na sledeću stranu. 

Da bismo izbjegli ovakve situacije, podesićemo tok teksta u odlomku u dijaloškom okviru 
Odlomak. 
 
Kliknemo na strelicu u desnom donjem uglu trake Paragraf a zatim izaberemo karticu Line and 
Page Breaks. U polju prijelom stranica potrebno je potvrditi opciju "Window/Orphan control". 
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ODREĐIVANJE MARGINA STRANICE  U DOKUMENTU  

Margine stranice možemo odrediti pomoću lenjira i miša ili na traci Page Layout kliknemo na 
dugme Margins.  

 

Margine stranice možemo odrediti i klikom na tab Page Layout, kliknemo na dugme Margins 
pa na Custom Margins…U dijaloškom okviru Page setup na kartici Margins određujemo 
margine stranica u centimetrima, tako da u odgovarajuće polje upišemo određenu vrijednost. 
Takođe imamo kartice Paper i Layout. U polju From edge na kartici Layout određujemo 
margine za zaglavlje i podnožje, odnosno koliko će zaglavlje i podnožje biti udaljeno od ruba 
stranice.  

Zadatak 24      
(PRIPREMNI TEST ZA 
POLAGANJE MODULA)
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Ako želimo da margine dviju susjednih stranica budu preslikane kao u ogledalu, (npr. kod 
sadržaja knjige kada su unutrašnje margine stranica identične), potvrdit ćemo opciju "Mirorr 
margins". 
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Na kraju možemo izabrati da na jedan list papira ispišemo dva upola manja formata stranice. 

 

 
Na kartici Paper => Paper size izabraćemo željenu veličinu papira, a veličinu možemo odrediti i 
samo tako da unesemo vrijednosti za širinu i visinu papira u za to predviđena polja. 

Na traci Page Layout=> Orientation možemo birati smjer (način) ispisa stranice: Portrait 
(položena stranica) ili Landscape (vodoravno položena stranica). Na kartici Izgled određujemo 
izgled stranice, gdje počinje nova sekcija, hoće li parne i neparne stranice imati različita 
zaglavlja, ili će prva stranica biti različita od drugih. Ovdje određujemo uspravno poravnanje 
stranice prema vrhu, sredini, dnu ili obostrano. Izaberemo li uspravno obostrano poravnanje, tada 
će sadržaj stranice biti obostrano  poravnan, odnosno, bit će jednakomjerno razvučen od gornje 
do donje margine stranice. 
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Pomoću lenjira pomjeranjem margine gore pritisnemo tipku miša i povučemo marginu u 
željenom smjeru (povećamo je ili smanjimo). Na isti način možemo mijenjati desnu, gornju i 
donju marginu stranice. 
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ODREĐIVANJE POZADINE DOKUMENTA  

Pozadinu dokumenta, odnosno stranice određujemo traci Page Layout na traci Page 
Background. 
 
Kada postavimo kursor na naredbu Page Color, pojavi se paleta boja. Klikom na određenu boju, 
pozadina stranice ispuni se izabranom bojom. 

 

Klikom na dugme More Colors… pojavi se dijaloški okvir Colors. Ovdje biramo neku od 
ponuđenih boja, ili kliknemo na karticu Custom gdje možemo izabrati boju i podesiti njen 
intenzitet. 

 

 
 
Klikom na dugme Fill Effects… pojavi se dijaloški okvir u kojem možemo birati  prelazak jedne 
ili dviju boja preko stranice, s različitim stilovima sjenčenja. Kao podlogu možemo izabrati neku 
od tekstura ili uzoraka tako da je prvo označimo, a zatim kliknemo na dugme OK 
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. 

Kao pozadinu stranice možemo izabrati i neku sliku. Sliku biramo tako da otvorimo  karticu 
Picture, zatim kliknemo na dugme Select Picture, izaberemo željenu sliku (otvorimo folder gdje 
se slika nalazi i označimo je) i kliknemo na dugme OK 

Na stranicu Worda u pozadinu možete dodati VODENI ŽIG (WaterMark). Vodeni žig može biti 
fotografija ili tekst. 
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.  

Vodeni žig sa tekstom ORIGINAL. 
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NUMERISANJE STRANICA DOKUMENTA 

 

Numerisanje stranica u dokumentu možemo odrediti odmah na početku kreiranja dokumenta ili 
kada smo već kreirali cijeli dokument. 

Stranice numerišemo preko traka Insert => Page Number na traci Header&Footer. 

 

Pojavi se dijaloški okvir Brojevi stranica... u kojem određujemo položaj, poravnanje i oblik 
broja stranice. Položaj broja stranice može biti na vrhu i na dnu stranice. Poravnanje – biramo da 
li će se broj nalaziti uz lijevu ili desnu marginu stranice ili u sredini. Ako imamo dokument s više 
stranica, tada možemo birati da li će položaj brojeva na susjednim stranicama biti uz unutrašnje 
ili spoljašnje margine. 

 

Ako želimo da nam brojevi stranica počnu od određenog lista tada uključimo opciju "Start at" i 
napišemo broj lista. Kada odredimo sve parametre, izbor potvrdimo klikom o na dugme OK. 
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KREIRANJE ZAGLAVLJA I PODNOŽJA (HEADER & FOOTER) 
DOKUMENTA 

Što je ZAGLAVLJE I PODNOŽJE stranice dokumenta u MS Wordu? 

Zaglavlje je gornji dio a podnožje donji dio svake stranice u dokumentu. 

 

Na vrhu dokumenta pojavi se okvir za zaglavlje s tačkom unosa, a ostatak dokumenta je svjetlije 
boje (dok uređujemo zaglavlje ili podnožje, glavni dokument je nedostupan). 

U okvir zaglavlja ili podnožja unosimo podatke prema želji, npr. naziv preduzeća, adresu i sl. a 
možemo umetnuti i slike, npr. logotip kompanije i sl. 

Tekst i slike unosimo u zaglavlje i uređujemo ih na identičan način kao i u običnom tekstu – 
preko alatnih traka. 

 

 

Zadatak 21,22      
(PRIPREMNI TEST ZA 
POLAGANJE MODULA)
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UPOTREBA TAB-A U DOKUMENTU  

Tabovi se primjenjuju kada se pojavi potreba za pisanjem jednostavnijih tabelarnih prikaza, za 
pisanje cjenovnika, sadržaja knjiga, raznih popisa i listi, itd. 

Graničnici Tab-a su u Word-u izvorno postavljeni na svakih 1,27 cm, (svakim pritiskom na tipku 
Tab na tastaturi, kursor se pomiče za 1,27 cm. 

tipka TAB na tastaturi 

Tabove možemo postaviti i ukloniti pomoću dijaloškog okvira Tabs... i pomoću lenjira i 
dugmeta Tab-a.  

Postavljanje Tab-a pomoću dijaloškog okvira "Tabs" 

Kliknemo na tab Home => na strelicu u donjem lijevom uglu Paragrafa =>Tabs… 

 

  
 
Pojavljuje se dijaloški okvir Tabs u kojem zadajemo vrijednosti graničnika Tab-a, vrstu 
poravnanja Tab-a, kao i vodeće Tabove (kod vodećih Tabova se praznina lijevo od graničnika 
popunjava određenim znakovima (tačkicama, crticama ili punom crtom). 
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Postavljanje Tab-a jednakih vrijednosti 

Tabove jednakih graničnih vrijednosti određujemo u polju Default Tab stops. Klikom na 
strelicu prema gore, vrijednost graničnika Tab-a se povećava, a klikom na strelicu prema dolje se 
smanjuje. Vrijednost graničnika Tab-a može se takođe upisati u polje. Kada odredimo vrijednost 
graničnika, pritisnemo tipku Enter ili kliknemo na dugme OK. 

 
Određivanje vrste poravnanja Tab-a 

Vrstu poravnanja Tab-a određujemo u polju Alignment (lijevo, sredina, desno, decimalno 
poravnanje ili okomita crta). 

Postavljanje korisničkih Tab-a (različitih vrijednosti) 

U polju Tab stop position upisujemo vrijednosti graničnika Tab-a različitih vrijednosti. 

1. Upišemo vrijednost graničnika Tab-a. 

2. Odredimo poravnanje Tab-a. 

3. Odredimo vodeće znakove Tab-a (ako želimo). 

4. Kliknemo na dugme Set.  

Ponavljamo tačke 1-4 tako dugo dok ne postavimo sve Tabove, zatim kliknemo na dugme OK ili 
pritisnemo tipku Enter. 

Uklanjanje Tab-a 

Već postavljene korisničke Tabove uklanjamo na sljedeći način: 

1. U polju Tab stop position Tab-a kliknemo na vrijednost Tab-a koji želimo ukloniti. 
 
2. Kliknemo na dugme Clear  (ili Clear all ako želimo ukloniti sve Tabove). 

3. Zatim kliknemo na dugme OK ili pritisnemo tipku Enter. 

 Postavljanje Tab-a pomoću lenjira i dugmeta Tab-a 

Tabove možemo postaviti i preko dugmeta za Tabove koji se nalazi na vrhu dokumenta s lijeve 
strane lenjira. Svakim klikom na dugme mijenja se vrsta poravnanja Tab-a. 
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Postavljanje Tab-a  

1. Odredimo vrstu poravnanja Tab-a (klikom na dugme Tab-a). 

2. Kliknemo na donju polovinu lenjira na ono mjesto gdje želimo postaviti tracilator. 

Premještanje Tab-a  

Kliknemo na tab i kada se ispod njega pojavi isprekidana vertikalna crta, pomaknemo ga na 
željeno mjesto na lenjiru i otpustimo tipku miša. 

Uklanjanje Tab-a 

Kliknemo na tab, odvučemo ga s lenjira na radnu površinu, otpustimo tipku miša. 

KREIRANJE  TABELA  

Tabele možemo kreirati na dva načina: preko trake Insert => Table i preko trake Insert => 
Draw table. 

Kreiranje tablica preko trake Insert => Table 

1. Postavimo tačku (KURSOR) unosa tabele. 

2. Na standardnoj alatnoj traci kliknemo na dugme Table.  

3. Pritisnutom lijevom tipkom miša prelazimo preko ćelija i označimo broj redova i kolona u 
tabeli. 
 
4. Kada smo odredili broj redova i kolona, otpustimo lijevu tipku miša. 
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Tabela se pojavila u dokumentu na mjestu gdje se nalazio kursor.  

   
   
   
 Ovo je tabela 3x4  

 
1. Postavimo tačku unosa tabele u dokumentu (postavimo kursor na ono mjesto u dokumentu 
gdje želimo umetnuti tabelu). 

2. Kliknemo na taba Insert => Table =>Insert table. 
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  tabela  5x2   

U dijaloškom prozoru-okviru Insert table u polje Table size unesemo željeni broj kolona i 
redova klikanjem na strelice sa vrhom dolje i gore ili direktnim upisom  broja. 

Ako želimo, možemo odmah odrediti oblik tabele tako da kliknemo na dugme Table styles, a 
zatim u dijaloškom okviru izaberemo željeni oblik. 

Tabelu možemo nacrtati sami tako da kliknemo na traku Insert => Table => Draw table,  i 
crtamo pokazivačem miša koji se pretvorio u olovku. Pojavi se dijaloški okvir Tables tools, a 
pokazivač miša poprimi izgled olovke. Lijevom tipkom miša crtamo tabelu prema potrebi.  
Kad završimo s crtanjem, zatvorimo dijaloški okvir klikom na dugme CLOSE ( X ). 

 

 

 
KRETANJE UNUTAR TABELE  

Tabelom se možemo kretati pomoću miša i pomoću tastature. 

Kretanje tabelom pomoću miša 

Postavimo kursor (kliknemo) u bilo koju ćeliju u tabeli zavisno o potrebi. 

Po većim tabelama se možemo kretati pomoću klizača (tzv. scrollbar) 

Kretanje tabelom pomoću tiastature 

1. Pomoću tipke Tab pomičemo tačku unosa u sljedeću ćeliju, a kombinacijom tipki  Shift+Tab 
vraćamo se u prethodnu ćeliju. 
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2. Pomoću tipki sa strelicama – krećemo se znak ili ćeliju lijevo ili desno, odnosno  red iznad ili 
red ispod tačke unosa. 

3. Kombinacija tipki Alt+Home – postavlja tačku unosa u prvu ćeliju uredu, a Alt+End u 
posljednju. 
 
4. Kombinacija tipku Alt+Page Up – postavlja točku unosa u najvišu ćeliju u koloni, a Alt+Page 
Down u najnižu ćeliju u koloni. 

Ako je tabela velika, po njoj se možemo kretati pomoću tipki Page Up i Page Down. 

 

OZNAČAVANJE REDOVA, KOLONA I ĆELIJA U TABELI  

Označavanje redova i kolona u tabeli moguće je na dva načina: pomoću miša i preko menija 
Table. 

1. Red u tabeli možemo označiti tako da postavimo miš ispred reda  koji želimo  označiti. Kada 
miš promijeni oblik u strelicu nagnutu na desnu stranu, kliknemo lijevom tipkom miša. Red se 
zatamni, tj. označen je. Želimo li označiti više redova odjednom, držat ćemo pritisnutu lijevu 
tipku miša i vući miš prema dolje ili gore dok ne označimo sve redove koje želimo. 

 

2. Postavimo kursor (tačku unosa) u red koji želimo označiti, zatim kliknemo na traku Insert => 
Table =>Insert table=>Layout pojaviće se nova traka Layout i kliknemo na dugme Select. 

 



Microsoft word 2007 

 

Fakultet za informacione tehnologije ‐ Univerzitet Mediteran |  73 

 

 

Kolonu  možemo označiti tako da postavimo miša iznad kolone kojeg želimo označiti. Kada miš 
promijeni oblik u crnu strelicu okrenutu prema dolje, kliknemo lijevom tipkom miša. Kolona se 
zatamni tj. označena je. Želimo li označiti više kolona odjednom, držat ćemo pritisnutu lijevu 
tipku miša i vući miša ulijevo, odnosno udesno dok ne označimo sve kolone koje želimo. 

 

Ćelije označavamo tako da postavimo miš uz lijevi rub ćelije koju želimo označiti, a kada miš 
promjeni oblik u strelicu nagnutu na desnu stranu, kliknemo lijevom tipkom. Ćelija se zatamni 
(označi). Na ovaj način možemo označiti više ćelija odjednom, tako da vučemo miša preko svih 
ćelija koje želimo označiti. 

 

Drugi način da označimo cijelu tablicu je kliknuti na kvadratić s krstićem u  gornjem lijevom 
uglu tabele. 
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DODAVANJE I BRISANJE REDOVA I KOLONA U TABELI  

Redovi i kolone mogu se u tabeli dodati preko dugmeta Table i preko dugmea na grafičkoj 
Standardnoj alatnoj traci. 

Dodavanje redova u tabeli 

1. Postavimo tačku unosa (KURSOR) u red iznad ili ispod kojeg želimo umetnuti novi (ili 
označimo čitav red) 

2. Kliknemo na traku Insert => Table => Insert table =>Layout=> Insert Above, Insert 
Below, Insert Left,  Insert Right. 

Svakim klikom na dugme Insert umetne se novi red iznad označenog reda. 

 

Dodavanje redova i kolona u tabeli 

1. Označimo red ili kolonu (ili više njih) do kojeg želimo umetnuti novu kolonu. 

2. Kliknemo na dugme Insert => Table => Insert table =>Layout=> Insert Above, Insert 
Below, Insert Left,  Insert Right. 

Brisanje redova i kolona u tabeli 

1. Označimo red ili kolonu koji želimo izbrisati (ili više njih). 

2. Kliknemo na dugme Layout => Delete => Delete Cells ili Delete Columns. 

Ako hoćemo da izbrišemo cijelu tabelu kliknemo na dugme Layout => Delete => Delete Table 
 
Na označeni red ili kolonu možemo kliknuti desnom tipkom miša i izabrati naredbu Delete Cells 
ili  Delete Columns. 
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SPAJANJE I DIJELJENJE ĆELIJA U TABELI  

Spajanje ćelija 

Pojavi li se potreba da se podaci iz nekoliko ćelija objedine u jednu ćeliju, spojit ćemo nekoliko 
susjednih ćelija na sledeći način: 

1. Označimo ćelije koje želimo međusobno spojiti (ćelije se moraju međusobno dodirivati 
vodoravno ili horizontalno. 

2. Kliknemo na dugme Insert => Table => Layout=> Merge Cells. 

 

 ( ili kliknemo desnom tipkom miša na označene ćelije, a zatim u meniju na Merge Cells). 
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Plutajući meni pokrenut klikom desnom tipkom miša u ćeliju 

Nakon klika na Merge Cells ćelije će biti spojene u jednu ( kao i tekst ako se nalazi u ćeliji!). 

Dijeljenje ćelija 

Želimo li podijeliti određene ćelije na više dijelova, uraditi ćemo sledeće: 

1. Označiti ćeliju koju želimo podijeliti (ili više njih – možemo označiti čitavu kolonu). 
 
2. Kliknemo na traku Insert => Table => Layout=> Split Cells  

 

 

(ili kliknemo desnom tipkom miša na označene ćelije a zatim na naredbu Podijeli ćelije ). 
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Plutajući meni pokrenut klikom desnom tipkom miša u ćeliju 

3. U dijaloškom okviru Split Cells unesemo brojčanu vrijednost na koliko dijelova želimo 
podijeliti ćelije. 

 

Dijaloški okvir za podjelu jedne ćelije na više dijelova 

4. Potvrdimo klikom na dugme Ok ili pritisnemo tipku Enter. 

ODREĐIVANJE VISINE I ŠIRINE ĆELIJA U TABELI  

Visinu i širinu ćelija u tabelama možemo odrediti na dva načina: pomoću miša i pomoću 
dijaloškog okvira. 

Određivanje širine i visine ćelije pomoću miša  

Vršimo tako da pokazivač miša postavimo uz rub stupca tabele. Kada miš promijeni oblik u dvije 
okomite crte sa strelicama okrenutim ulijevo i udesno, kliknemo lijevom tipkom miša i preko 

Zadatak 18      
(PRIPREMNI TEST ZA 
POLAGANJE MODULA)
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ruba stupca se pojavi okomita isprekidana crta. Držimo pritisnutu lijevu tipku miša i  pomičemo 
rub kolone, tj. proširimo ili suzimo kolonu prema želji. 

  

 
Na identičan način možemo odrediti i visinu reda (pokazivač miša postavimo uz rub reda). 
 
Označimo li samo jednu ćeliju, tada će se proširivanje, odnosno sužavanje odnositi samo na 
označenu ćeliju. Na ovaj način možemo određivati širinu kolone i visinu reda kada sve kolone i 
redovi u  tablici ne moraju imati iste vrijednosti. 

Ako želimo red proširiti ili suziti od onda uvijek hvatamo donji rub reda, a ako želimo kolonu 
(ćeliju) proširiti ili suziti hvatamo ga za bilo lijevi ili desni rub kolone. 
 
Određivanje visine i širine ćelije pomoću dijaloškog okvira 

Označimo ćeliju (ili više njih, čitav red ili kolonu ili cijelu tablicu). Kliknemo na traku Insert => 
Table => Layout=>Properties. 
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U dijaloškom okviru Svojstva tabele (Table Properties), na kartici Table možemo odrediti 
tačnu veličinu tabele, njen položaj na stranici (uz lijevi rub, desni rub ili u sredini) i omotati 
tablicu u tekst.  

 

Na kartici Row možemo podesiti visinu reda. Podešena je automatska visina reda, što znači da će 
se tekst u ćelijama lomiti i automatski povećati visinu reda. Potvrdimo li opciju Specify height, 
tada možemo odrediti tačnu i najmanju visinu reda u centimetrima. 

Odredimo li tačnu visinu reda u centimetrima, tada će visina reda iznositi tačno toliko koliko 
odredimo. Ako će se sadržaj neke ćelije lomiti u nekoliko redova, tada je moguće da se drugi ili 
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treći red sadržaja ćelije ne vidi, upravo zbog ograničene visine reda. Tada je bolje ostaviti 
automatsku visinu reda. 

Pomoću dugmeta Previous row i Next row možemo pojedinačno svakom redu odrediti visinu. 

Na kartici Column možemo odrediti tačnu širinu kolone ( ili više njih ako smo ih više označili). 
Pomoću dugmeta Previous Column i Next Column možemo pojedinačno svakoj koloni odrediti 
širinu.  

 

Na kartici Cell možemo mijenjati širinu ćelija i odrediti poravnanje sadržaja ćelije uz vrh, 
sredinu ili dno ćelije. 
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BROJANJE REDOVA 

U Wordu 2007 možete brojati (vidno prikazati) koliko redova ima određeni dokument ili sekcija. 

 

Ako ste napravili prelom stranice Page break imate mogućnost početka brojanja redova od 1....  
počevši od druge stranice u istom dokumentu. 
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Kliknite na traku Page Layout=> Line numbers =>Line numbers Options… 

Otvara Vam se novi prozor pod naslovom Page set up, gdje kliknete na karticu Layout => Line 
Numbers… i numerisanje izaberite po želji. 

RAZVRSTAVANJE PODATAKA U TABELI 

Podatke u tabelama možemo razvrstati pomoću naredbe Sort pod tabom Table tools=> Table 
Layout. Označimo tablicu ili postavimo kursor u bilo koju ćeliju, kliknemo na meni  Table 
tools=> Table Layout=>Sort. 

 

U dijaloškom okviru Sort odredimo po kojoj koloni želimo razvrstati podatke i kojim 
redosledom: uzlaznim ili silaznim. 

Podatke možemo razvrstati po tri kolone, tako da u polju Sort by odredimo prvu kolonu po kojoj 
će se podaci razvrstati i kojim redosledom, u polju Then by odredimo drugu, a nakon toga i 
treću kolonu. Zatim kliknemo na dugme OK. Klikom na dugme Options… imamo još 
mogućnosti sortiranja. 
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OBLIKOVANJE TABELE 

Oblikovanje tabele podrazumijeva oblikovanje sadržaja tabele (teksta) i samog izgleda tabele. 
 
Oblikovanje sadržaja, odnosno teksta u tabeli, vrši se na identičan način kao i oblikovanje 
ostalog teksta: pomoću alatne trake Font  ili pomoću taba Home => Font gdje možemo odrediti 
različitu veličinu ispisa, boju, podebljanja i ostale efekte zavisno o želji. 

Oblikovanje izgleda same tabele vršimo na više načina: 

1. Prvo kreiramo tabelu a naknadno određujemo okvire i sjenčenja određenih polja pomoću 
dugmeta Properties => Borders and Shading… i sjenčenja ili pomoću desnog klika miša 
Borders and Shading…   

2. Prilikom kreiranja tabele kad u dijaloškom okviru Insert =>Table odredimo broj redova i 
kolona, odmah odredimo i oblik tabele, tako da izaberemo neki od ponuđenih oblika. Kliknemo 
na dugme Table Styles, a zatim u dijaloškom okviru Table Styles izaberemo željeni oblik. 
 
3. Treći način je da gotovoj tabeli dodijelimo neki od gotovih oblika. Označimo tabelu ili 
postavimo kursor u bilo koju ćeliju, kliknemo na meni Table=> Quick Tables. U dijaloškom 
okviru Quick Tables tabele izaberemo željeni oblik. 

 

 

SJENČENJE TABELA  

Prvo kreiramo tabelu klikom na traku Insert =>Table  

Zavisno što želimo oblikovati u tabeli (ćelije ili okvir), to selektujemo.  

Oblikovanje možemo vršiti na dva načina: 

- preko alatne trake  

- desnim klikom miša na selektovano, zatim na Table Properties  

Zadatak 19      
(PRIPREMNI TEST ZA 
POLAGANJE MODULA)
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Na ovom dijalog prozoru (slika iznad) možete birati što ćete raditi sa selektovanom ćelijom. 
Ako joj želite nacrtati deblji okvir i obojati ga to radite na kartici Borders,  a ako je želite obojati 
to radite na kartici Shading . 

 

KREIRANJE TEMPLEJTA (ŠABLONA) 

Templejt možemo kreirati vlastitim stilovima ili pomoću postojećih obrazaca u MS Word-u. 

Izrada templejta (šablona) sa vlastitim stilovima 

Otvorimo novi dokument i kreiramo templejt pomoću postojećih ili vlastitih stilova. 

Kreiramo zaglavlje i podnožje templejta te područje za unos teksta koristeći sve mogućnosti 
Microsoft Word-a: naredbe za oblikovanje znakova i odlomaka, okvire s tekstom, umetnuti logo 
ili slike u templejt, okvire i sjenčenja, ili odrediti pozadinu templejta zavisno o željama i 
kreativnosti. 
 
Kad uredimo templejt prema želji, sačuvati ćemo ga pod određenim imenom (npr. fax obrazac ili 
pismo) kao Templejt dokumenta gdje u tom momentu dobija nastavak (extenziju) *.dot (u 
dijaloškom okviru Save kao u polju Save u obliku izabrati ćemo Templejt dokumenta). 
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Sledeći put kada otvorimo dijaloški okvir Office Button => New na okviru s desne strane 
prozora New document, nalazit će se templejt koji smo kreirali. 
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Templejt otvorimo dvostrukim klikom na njegovo ime, unesemo tekst i zatim ga sačuvamo kao 
običan Wordov dokument (*.docx) u folder  koju želimo (u stvari nećemo ga moći sačuvati kao 
već postojeći dokument jer će nas Word usmjeriti na dijaloški okvir Save as, a time smo 
osigurani da ne možemo zabrljati templejt) 

Izrada templejta pomoću postojećih obrazaca u Microsoft Word-u 

Otvorimo novi dokument s templejtom s time da kod otvaranja dokumenta u dijaloškom okviru 
My Templates na kartici New, u polju Create New potvrdimo opciju Template. (vidi sliku 
gore) 
 
Nakon što smo otvorili postojeći templejt, u odgovarajuća polja unesemo podatke koje želimo 
imati u templejtu (naziv poduzeća, adresa, telefon, logo itd.). 

 
 
 

Kod čuvanja dokumenta u dijaloškom okviru Save as odredimo ime templejta i kliknemo na 
dugme Save. 
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PISANJE TEKSTA U KOLONAMA  

Želimo li tekst cijelog dokumenta presložiti u kolone, kliknemo na dugme Columns na traci 
Page Layout, a zatim označimo broj kolona u koje ćemo presložiti tekst. Kolone označimo tako 
da prelazimo mišem preko njih, a kad označimo željeni broj kolona, kliknemo na njega. 

 

Kolone možemo oblikovati i preko dugmeta More Columns Možemo izabrati više kolona iste ili 
različite širine, odrediti njihovu širinu i razmak među njima, te hoće li ih dijeliti crta. Kada 
izaberemo postavke prema želji, kliknemo na dugme OK. Pisanje teksta u kolonama možemo 
odrediti odmah na početku pisanja dokumenta. 
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WORD-ART Ukrasne riječi  

Naslove i pojedine riječi u dokumentu možemo posebno naglasiti pomoću WordArta ili 
ukrasnih riječi. 

 

 
 
WordArt pokrećemo klikom na traku Insert => WordArt na traci Text ili kliknemo na meni. 
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Pojavi se dijaloški okvir Galerija WordArta u kojem izaberemo oblik ukrasnih riječi i 
kliknemo na izabrani dizajn. Zatim se pojavi dijaloški okvir Uređivanje teksta WordArta u 
koji unosimo tekst. 

U ovom dijaloškom obliku možemo mijenjati font, veličinu fonta i stil napisanog teksta. Kada 
kliknemo na dugme OK, tekst koji smo napisali pojavi se u dokumentu u izabranom obliku 
WordArta. 

 

Kada označimo WordArt, u prozoru Worda pojavi se alatna traka WordArta pomoću koje 
možemo uređivati WordArt. Pomoću dugmadi na alatnoj traci možemo urediti tekst WordArta, 
oblikovati WordArt pomoću dijaloškog okvira Format WordArt u kojem mu možemo 
mijenjati boje, veličinu i izgled, zatim mijenjati oblik WordArtu, rotirati ga, umotati u tekst, 
ispisati okomitim slovima i mijenjati razmak među slovima.        

 

 

PROVJERA PRAVOPISA DOKUMENTA  

 
Nakon što smo dokument napisali, možemo provjeriti njegovu pravopisnu i gramatičku 
ispravnost.  
 
Ako označimo dio dokumenta, tada će se provjera pravopisa i gramatike odnositi samo na 
označeni dio, u protivnom će Microsoft Word izvršiti provjeru kompletnog dokumenta.  
Provjeru dokumenta pokrećemo klikom na tab Review=> Spelling&Grammar na alatnoj traci 
Proofing . 
 

Zadatak 23      
(PRIPREMNI TEST ZA 
POLAGANJE MODULA)
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Pronađe li Microsoft Word grešku u pravopisu, pojavi se dijaloški okvir Spelling&Grammar u kojem 
crvenim slovima piše neispravno napisana riječ, a mi biramo da li  ćemo neispravno napisanu riječ 
zanemariti ili ćemo je zamijeniti s riječi koju Microsoft Word nudi u okviru Prijedlozi. Zavisno od 
odluke kliknut ćemo na dugme Zanemari (Ignore Once ili Ignore All)  ili na dugme Promijeni 
(Change). 
 

 
 
 
Na kraju nas program upozori da je provjera pravopisa i gramatike dovršena. 
 
Želimo li provjeru pravopisa i gramatike u toku pisanja dokumenta, tada ćemo u dijaloškom okviru 
Pravopis i gramatika kliknuti na dugme Options, a zatim potvrditi Provjeri Check spelling as you 
type. 
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Nakon toga će se automatski prilikom pisanja dokumenta neispravno napisane riječi podcrtati 
crvenom krivudavom crtom, a neispravna gramatika zelenom krivudavom crtom. 

U Microsoft Wordu 2007 podešeno je da se provjera pravopisa i gramatike vrši u Engleskom 
jeziku. Pojavi li se potreba za provjerom pravopisa i gramatike u nekom drugom jeziku, tada taj 
jezik treba postaviti na način, da se klikne na traku Review=> Spelling&Grammar 
=>Options…=>Popular=>Language Settings…=>Primary editing language postavite na na 
traženi jezik. 

Ako nemate gramatičku  provjeru za starije verzije MS Worda istu možete sa Microsoft –ovog 
web sajta. Ovaj programčić raspakujte na Vaš HDD i pokrenite datoteku crospell.exe 
Podrška gramatičke provjere za MS Word 97, 2000, 2002, 2003. 
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PRETRAŽIVANJE I ZAMJENA TEKSTA  

 
Pretraživanje teksta vršimo na traci Home => Find na alatnoj traci Editing ili pritisnemo 
kombinaciju tipki Ctrl+F. 
 
Otvara se dijaloški okvir Find and Replace u kojem možemo pretraživati i zamijeniti određene riječi u 
dokumentu.. 
 

 
 
Dijaloški okvir Find and Replace sadrži tri kartice. Na kartici Find možemo samo tražiti određene riječi 
u dokumentu. U polje Find what upišemo riječ ili dio riječi koju treba tražiti, a zatim kliknemo na dugme 
Find Next.  Microsoft Word pronađe traženu riječ i označi je. Svakim narednim klikom na dugme Traži 
sljedeće, Microsoft Word će pronaći sljedeću riječ koja odgovara traženom pojmu. Na kraju nas program 
kratkom porukom obavijesti da je izvršio pretraživanje. Klikom na dugme više možemo odrediti i dodatne 
mogućnosti pretraživanja, npr. traži sve oblike riječi i dr., tako da uključimo potvrdnu kvačicu. 
 
Želimo li određenu riječ koja se više puta pojavljuje u tekstu zamijeniti drugom, tada ćemo u dijaloškom 
okviru Find and Replace kliknuti na karticu Replace.  
 
U polje Find what  unosimo riječ koju želimo mijenjati, a u polje Replace with  riječ koja će doći na 
njeno mjesto. Zatim kliknemo na dugme Zamijeni, pri čemu Microsoft Word pronalazi zadanu riječ, a mi 
svaku promjenu moramo pojedinačno potvrditi klikom na dugme  Replace. 
 
Drugi način je da odmah kliknemo na dugme Replace all, pri čemu Microsoft Word izvrši sve izmjene, i 
obavijesti nas koliko je izmjena napravljeno. 
 
Na kartici Go To imamo mogućnost brzog traženja u velikim dokumentima, tako da u polju Go To 
označimo koji dio dokumenta tražimo, npr. stranicu, a u polju s desne strane upišemo broj stranice (ili 
sekcije, naslova itd). 
 
 
 
 
 
 

Zadatak 7      
(PRIPREMNI TEST ZA 
POLAGANJE MODULA)
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BROJANJE RIJEČI I ODLOMAKA  U DOKUMENTU  

Ako ste ikada imali potrebu prebrojiti sve riječi u dokumentu a niste znali evo kako se to radi. 

1. Otvorite dokument u kojem želite izbrojiti riječi ili odlomke. Na traci Review =>Word 
Count  

 

2. Otvorit će Vam se prozor na kojem imate popis nekih parametara dokumenta  
 

 
 

KREIRANJE CIRKULARNOG ( SKUPNOG ) PISMA  

 
 
Da li Vam se kada dogodilo da trebate napisati više pisama ali iz kurtoazije želite svako pismo 
adresirati određenoj osobi. Sve ste morali ručno pisati. No da se ne bi više tako mučili, naučite 
kako se to može pomoću MS Worda. ( u ovom slučaju opisujem izradu cirkularnog pisma (Mail 
Merge ) u MS Word 2007 EN. 
 
Uslov za izradu "Cirkularnog" pisma je baza podataka sa parametrima adrese i ako još hoćete 
titule, e-maila i slično. Istu možete izraditi u Excelu ili u Accessu. Sačuvati je i kada Vam 
zatreba upotrijebiti. Ja sam u ovom slučaju izradio bazu u Excelovoj tablici. 

Zadatak 
27,28,29,30,31,32      

(PRIPREMNI TEST ZA 
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Sada kada imate pripremljenu bazu možete pristupiti izradi "Cirkularnog pisma"( Mail Merge).  
Pokrenite MS Word 2007 i na traci "Mailings" i na alatnoj traci Start Mail Merge izaberite 
Step by Step Mail Merge Wizard.  

 

 
Sada Vam se u desnom dijelu Wordovog prozora pojavilo tzv. Prozor pod naslovom "Mail 
Merge". Napominjem, da se ovo PROZOR ne mora nalaziti na desnoj strani prozora. Može biti 
i iznad "papira" kao traka. No to je jedno te isto, samo je stvar izgleda i rasporeda opcija. 
Na istom trebate checkirati "kućicu" ispred opcije "Pisma" (Letters), a potom kliknuti na 
slijedeći korak pri dnu prozora "Polazni dokument" (Starting Document ) 
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Ovo je slijedeći korak u prozoru i ovdje trebate checkirati kućicu "Koristi trenutni dokument" 
(Use the current document). Potom klik na dnu prozora na naredbu "Izaberi primaoce" ( 
Select recipients ) 

 

 
Ovdje ćemo checkirati "Koristite postojeću listu" ( Use an existing list ) jer smo već unaprijed 
pripremili bazu (vidi korak 1). (Vi možete izabrati i druge dvije opcije ali njima se služe ljudi 
koji uvoze parametre adresa iz MS Outlook-a ili izrade novog popisa u samom Wordu). Mi se 
baziramo na prvu opciju Use an existing list. Potom trebate kliknuti na link "PREGLEDAJ" 
(Browse ) 
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Sada nam se otvorio dijaloški prozor u kojem trebamo izabrati našu bazu podataka koju smo 
ranije izradili u Excelu. U ovom slučaju ista ima naziv "baza-cirk-pismo1" a po ikoni ispred 
vidimo da je izrađena u Excelu. Dvoklik na bazu. 

 

Nakon odabira izvora podataka tj. baze, otvara nam se novi prozor "Odabir tablice" (Select 
table) u kojem trebamo odabrati list (Sheet1) u kojem se nalazi baza. Potom klik na ( Ok )  
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Otvara nam se prozor "Primaoci cirkularnog pisma" (Mail Merge Recipients) na kojem 
vidimo sve parametre unešene u bazu. Možete uočiti da možete imati na stotine primaoca u bazi 
ali samo određenim možete poslati željeno pismo (pomoću filtera u kao u Excelu) tj. one koje 
checkirate u dotičnom redu. Takođe uočite redoslijed kolona (koji nam ne odgovara). Iste 
možemo "isprebacivati" sistemom "Povuci i spusti" (Drag and Drops). Vidi sliku 8 i 8a. 
Dakle, kliknemo LTM na kolonu gdje piše "prezime i ime" zadržimo tipku i povučemo kolonu u 
lijevo ispred kolone "adresa" a potom spustimo tj. otpustimo tipku miša. ITD... 
Zašto sam rekao da možemo imati stotine u bazi a samo dio primaoca. Za to nam služe crni 
trokutići vrhom prema dolje, tj. pomoću njih možemo filtrirati ako želimo određene primatelje ( 
npr: ako želimo samo primaoce iz Podgorice, ili samo one koji Imaju prezime Petrović, a u 
nekim slučajevima npr: samo one koji imaju prodaju veću od 1000 eur-a itd.... sve zavisii o 
parametrima u bazi). Nadalje checkiramo samo one kojima šaljemo pismo, ostale isključimo. 
Kliknite na (Ok ) . 

 

 
Sada ste se vratili u Wordov prozor na "bjanko dokument". Uočite na prozoru "Mail Merge" 
stavke poput "Odabir drugog popisa" (Select a diferent list), "Uredi popis primatelja" (Edit 
recipient list...). Znači još imate vremena izvršiti neke promjene. Ove opcije Vam služe ako 
želite nešto promijeniti ili izabrati drugu listu primaoca. Kliknite na link "Napišite pismo" 
(Write your letter )  
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Sada mežemo pisati pismo. Kao svaka ozbiljna firma postaviti ćemo svoju adresu 
(memorandum) a potom postaviti kursor na mjesto gdje ćemo unijeti željeno "linkovano" polje 
koje će "vući" podatak iz baze. Uočite na prozoru prozora slijedeće stavke:  
Adresni blok, (Address block), Pozdravni red, (Greeting line), Elektronička poštarina 
(Electronic postage, koji mirate instalirati zasebno), Dodatne stavke (More items). 
 
Ovdje možete isprobati razne opcije, a nešto komplikovanija je "Adresni blok" (Address block) 
koja nudi dosta opcija i mogućnosti formatiranja oblika primaoca.  

Dakle, postavili smo kursor na mjesto i klik na "Dodatne stavke" (More items...). Otvorio nam 
se ovakav prozor: 

 

Selektujemo "ime i prezime" a potom klik na "UMETNI" ( Insert ) pa na "ZATVORI" (Close) 
Idemo opet nanovo da umetnemo "adresa", "mjesto", i "e-mail" I  
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Posle toga postavim kursor na mjesto i klik na "Pogledajte vaše pismo" (Preview your 
letters...) i dobićemo ovakav rezultat. Prebacimo se u novi red i napišimo pismo. Sada smo 
završili pripremu za ispis "Cirkularnog pisma", tj. linkovana polja su nam podloga koja će vući 
parametre iz baze prilikom ispisa. Idemo kliknuti na "Pretpregledajte pismo" (Preview your 
letters) u dnu prozora prozora "Cirkularna pisma". Dobili ste prvog primaoca (iz baze) pisma 
na mjestu linkovanog parametra. Klikom na dugme >> možemo pregledavati primatelje tj. 
promjene na linkovanim parametrima, a potom ako smo se sjetili možemo pojedinog primaoca i 
isključiti ili promijeniti popis primaoca.  

Linkovana polja sa bazom 
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Sada možemo pristupiti ispisu svih pisama za primaoce koje smo izabrali iz baze. Klik na dugme 
"ISPIŠI" ( print ) 

 

Izgleda dosta komplikovano, ali kada jednom oformite bazu u Excelu sa unaprijed dobro 
razrađenim parametrima i izradite ovakvo jedno cirkularno pismo, nema straha i brzo možete 
doći do ispisa "Cirkularnog pisma" za stotine primaoca. 
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Postoji još brži način kada jednom izradite OSNOVU za "Cirkularno pismo": 

Kada jednom formirate "Cirkularno pismo" i dođete do koraka kada ste unijeli memorandum i 
linkovane parametre iz baze (vidi korak 10 ovog tutora), snimite isti dokument pod nazivom npr: 
osnovna-baza-cirk-pisma.doc u istu mapu gdje je i baza u Excelu (ili još bolje kao osnovna-baza-
cirk-pisma.dot. *.dot je sigurniji da nećete moći "zbrljati" nešto, Word Vam neće dati da snimate 
pod istim imenom datoteku tj. pismo. Uvijek će Vam nuditi da upišete novo ime za novo pismo). 
Uvijek ga možete koristiti kao template za izradu cirkularnog pisma i nećete morati prolaziti sve 
ove korake. 

UMETANJE TABELA I GRAFIKONA IZ EXCELA  U MICROSOFT 
WORD-u 2007  

 
U Wordov dokument možemo umetnuti proračunsku tabelu, dio tabele ili grafikon iz Excela 
pomoću naredbi Kopiraj (Copy) i Zalijepi (Paste), ili pomoću Clipboard . 
 
Otvorimo radnu knjigu u Excelu, označimo tabelu, dio tabele ili grafikon koji želimo umetnuti u 
Wordov dokument i kopiramo ga pomoću naredbe Kopiraj (Copy)  u Clipboard.  
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Premjestimo se u Wordov dokument, postavimo kursor na ono mjesto u dokumentu gdje želimo umetnuti 
tabelu, i kliknemo na dugme Paste => Paste special 

U dijaloškom okviru Posebno Ljepljenje odredimo što želimo zalijepiti ( Radni list Microsoft Excela 
Objekt ) i način na koji želimo zalijepiti, s vezom (Paste Link) ili bez. 

 

Ako želimo da radna tabela ili grafikon umetnuti u Wordov dokument održavaju vezu s izvornim 
dokumentom u Excelu na način da se svaka promjena u tablici u Excelu odrazi na kopiju tablice u Wordu, 
tada potvrdimo opciju "Zalijepi vezu" i kliknemo na dugme OK. 

Ako ne želimo vezu među tabelama, označimo opciju "Paste" i kliknemo na dugme OK. 

Proračunska tabela  se umetne na ono mjesto u dokumentu, gdje se nalazio kursor. 
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UMETANJE EXCELOVOG RADNOG LISTA  U MICROSOFT WORD-u 
2007 

U Wordov dokument možemo umetnuti  Excelov radni list na način da kliknemo na traku Insert pa na 
dugme Table => Excel Spreadsheet. 

 

Otvoriće se radni list Microsoft Excel-a , unosimo podatke u ćelije, možemo promijeniti visinu redova i 
širinu kolona pomoću miša, a možemo takođe vršiti i proračune. Umetnuti radni list ili proračunsku tabelu 
možemo označiti klikom na nju, a zatim je premjestiti ili kopirati na drugo mjesto u dokumentu ili je 
izbrisati. 

 

PISANJE FORMULA I JEDNAČINA  

 
1. Pokrenite program Word 2007 i na mjesta u tekstu gdje trebate napisati formulu ili jednačinu 
postavite kursor 
 
2.Na tekstualnom meniju kliknite na grupnu naredbu Insert a potom na Object 
 
3. Na novootvorenom prozoru "Objekt" klizačem pronađite "Microsoft Equation 3.0"  
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4. Sada ste se vratili na list tj. Vaš dokument i imate otvoren grafički meni "Equation" 
 

 
 
 
5. Na mjestu gdje ste postavili kursor pojavio se okvir u koji će te upisati formulu.  
Na grafičkom meniju izaberite formu SIMBOLA za vaše brojeve i matematičke operacije ( klikom na 
jedan od simbola otvara Vam se padajući meni ). 
 

 

NAPOMENA: U koliko nemate na popisu "Microsoft Equation 3.0" trebate ga doinstalirati. 
Instalaciju Microsoft Equation 3.0 možete izvesti na slijedeći način: 

1. “Start/Settings/Control Panel,” and open “Add/Remove Programs.”  

2. Klikni na MS Office pa klikni na „Change“. U sljedećem prozoru uvjeri se da je „Add or remove 
features“ kockica selektovana i klikni Next. 

3. Morat ćete proširiti Office Tools tako da kliknete na znak „+“. Desni klik na „Equasion Editor“ (trebao 
bi biti na listi) i selektuj „Run from my computer“. Klikni „Update“ tipku na dnu i Equation Editor će se 
instalirati. 
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4. Idi na „Insert/Object,“ i izaberi „MS Equasion 3.0“ (ili koju već verziju imate) 
Moguće je da će iskočiti prozor u vezi „Math Type,“ „nadogradnje“ Equation-a ... on naravno nije 
besplatan. Nakon što ste kliknuli na „OK“ tipku, tvoj Word document će imati box na sebi i pojavit će se 
alatna traka. 

 

PISANJE KOMENTARA U MICROSOFT WORD-u 2007  

 
Jeste li ikada čitali nekakav tekst koji ste davno napisali ili možda neku stručnu literaturu i 
pomislili kako bi bilo dobro da neka nepoznata riječ bude objašnjena. Napišete tekst i neku riječ 
koju želite objasniti "selektujte" pa potom ubacite komentar za dotičnu riječ tj. objašnjenje.  
Na tekstualnom meniju ispod naslovne trake kliknite na Review => NEW COMMENT 
(Komentar). 
 

 

ZAŠTITA DOKUMENATA  

 
NAPOMENA: Postoji mogućnost da kod Vas nije ovakav način zbog razniih vrsta i update-a ali 
sličnost je neizbježna. 

Zaštita od otvaranja  

Zaštita dokumenata od otvaranja vrši se odabirom naredbe Office Button => SAVE AS => 
TOOLS => General Options .  
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U polje za "Pasword to open" ( Lozinka za otvaranje ) upisati lozinku ( ali zapamtite velika i mala 
slova kao i brojeve). Ovu lozinku razbijaju neki programi za razbijanje šifri ali što je duža i 
komplikovanija to ju je teže razbiti. 

Zaštita od promjena 

Ako želite dokument zaštititi od promjena izabrite lozinku i u polju "Password to modify" ( Lozinka za 
izmjenu)  
 
Dodatna zaštita od promjena 

Ako želite dokument zaštititi od dodatnih promjena sa tekstualnog menija "TOOLS" ( Alati ) izaberite 
"Protect document" (Zaštiti dokument), pa potom izaberite opcije koje želite. 

 

 

 


